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24
25

XML analysis 0 37 39
Network Trace analysis 0 11 11
Total: 0 835 14 849

Open Fixed

Bug Reports 14 1

Total

15

With comments



To Do

Section Comment

Integration

Target Windows

Step Test Case Action Comment
1 Verify C/C++ EPP Package RC1
1.1 Download EPP Package Download, extract and start EPP package EPP Package starts Pass
Verify that all tracing features and plug-ins are present and have the
1.2 Version of Tracing Features Go to Help -> About Eclipse -> Installion Details correct version (TMF, LTTng, CTF, GDBTrace) Pass
1.3 TMF presence Open Tracing perspective Tracing perspective opens Pass
1.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Pass
1.5 GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Pass
Go to Help -> Install New Software... -> Update site "Mars -
Mars Update Site http://download.eclipse.org/releases/mars" Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab Pass
2 Verify C/C++ EPP Package RC2
Download, extract and start EPP package. Check the mailing list for the pac
2.1 Download EPP Package https://dev.eclipse.org/mailman/listinfo/epp-dev EPP Package starts Pass
Verify that all tracing features and plug-ins are present and have the
2.2 Version of Tracing Features Go to Help -> About Eclipse -> Installation Details correct version (TMF, LTTng, CTF, GDBTrace) Pass
2.3 TMF presence Open Tracing perspective Tracing perspective opens Pass
2.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Pass
2.5  GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Pass
Go to Help -> Install New Software... -> Use the testing update site "Mars -
2.6 Mars Update Site http://download.eclipse.org/releases/mars" Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab Pass
3  Verify C/C++ EPP Package RC3
3.1 Download EPP Package Download, extract and start EPP package EPP Package starts Pass
Verify that all tracing features and plug-ins are present and have the
3.2 Version of Tracing Features Go to Help -> About Eclipse -> Installation Details correct version (TMF, LTTng, CTF, GDBTrace) Pass
3.3 TMF presence Open Tracing perspective Tracing perspective opens Pass
3.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Pass
3.5 GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Pass
Go to Help -> Install New Software... -> Use the testing update site "Mars -
3.6 Mars Update Site http://download.eclipse.org/releases/mars" Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab Pass /mars wasn't up to date yet, tested /staging instead
4  Verify C/C++ EPP Package RC4
4.1 Download EPP Package Download, extract and start EPP package EPP Package starts Pass
Verify that all tracing features and plug-ins are present and have the
correct version (TMF, LTTng Control, LTTng Kernel, LTTng UST,
4.2 Version of Tracing Features Go to Help -> About Eclipse -> Installation Details CTF, GDBTrace) Pass
4.3  TMF presence Open Tracing perspective Tracing perspective opens Pass
4.4 LTTng presence Open LTTng Kernel perspective LTTng Kernel perspective Pass
4.5 GDB Tracepoint Analysis presence Open GDB Trace perspective GDB Tracepoint analysis perspective Pass
Go to Help -> Install New Software... -> Use the testing update site "Mars -
4.6 Mars Update Site http://download.eclipse.org/releases/mars" Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab Pass /mars wasn't up to date yet, tested /staging instead
5 Verify Update Site

Download Eclipse standard and install LTTng Kernel, LTTng Control,
LTTng UST, GDBTrace and PCAP Network Analysis from main Mars
testing Update site
5.1 Mars Update Site "Mars - http://download.eclipse.org/releases/mars" Verify that installation was successful Pass

Download Eclipse standard and install LTTng Kernel, LTTng Control,
LTTng UST, GDBTrace and PCAP Network Analysis from the Linux Tools
Update site
5.2 Trace Compass Update Site http://download.eclipse.org/tracecompass/mars/milestones Verify that installation was successful Pass

Download Eclipse standard from Luna SR2 and install LTTng, LTTng
Kernel, GDBTrace and PCAP Network Analysis from main Luna Update
site.
http://download.eclipse.org/releases/luna
Try to update the installation using the testing Mars update site.
5.3 Upgrade using Mars Update Site Mars - http://download.eclipse.org/releases/mars Verify that installation was successful Pass



5.4

5.5

6.1

6.2

Upgrade using Trace Compass Update
Site

Upragde from previous EPP

Verify Update Site

Trace Compass update site

Upgrade using Trace Compass
update site

Download Eclipse standard from Luna SR2 and install LTTng, LTTng

Kernel, LTTng UST, GDBTrace and PCAP Network Analysis from the

Trace Compass release Update site.

http://download.eclipse.org/tracecompass/releases/0.1.0/repository

Try to update the installation using the Trace Compass update site
http://download.eclipse.org/tracecompass/mars/milestones Verify that installation was successful

Download Eclipse previous C/C++ EPP package. Try to upgrade using both
update sites:

(TODO find correct job: https://hudson.eclipse.org/packaging/job/luna.epp-
tycho-build/128/artifact/org.eclipse.epp.packages/archive/repository/)
"Mars - http://download.eclipse.org/releases/mars"

The information about the update sites to use is usually posted on epp-dev Verify that installation was successful

Release outside release train

Download Eclipse standard and install LTTng Kernel, LTTng Control, LTTn
UST, GDBTrace and PCAP Network Analysis from main
Update site: http://download.eclipse.org/tracecompass/stable/repository/ Verify that installation was successful

Download Eclipse standard from Luna SRO and install LTTng, LTTng

Kernel, LTTng UST, GDBTrace and PCAP Network Analysis from the Luna

SRO Linux Tools Update site.

http://download.eclipse.org/linuxtools/update-3.1

Try to update the installation using the Trace Compass update site.
http://download.eclipse.org/tracecompass/stable/repository/ Verify that installation was successful

N/A

N/A

Also needed Eclipse 4.5 repo and Remote repo because of o.e.rem



Section Pass

Junit Tests

Ubuntu 12.04 64 bit and on

Target Hudson

Step Test Case Action
1 Junit Test Cases
1.1 CTF Core Tests Plug-in Run manually or with Jenkins
1.2 CTF Parser Tests Plug-in Run manually or with Jenkins
1.3 State System Core Tests Plug-in  Run manually or with Jenkins
1.4 TMF Core Tests Plug-in Run manually or with Jenkins
1.5 TMF Ul Tests Plug-in Run manually or with Jenkins
1.6 TMF Ul SWTBot Tests Plug-in Run manually or with Jenkins
CTF Support for TMF SWTBot
1.7 Tests Plug-in Run manually or with Jenkins
TMF Xml Analysis Core Tests
1.8 Plug-in Run manually or with Jenkins
TMF Xml Analysis Ul Tests Plug-
1.9 in Run manually or with Jenkins
1.10 LTTng Control Core Tests Plug-in Run manually or with Jenkins
1.11 LTTng Control Ul Tests Plug-in  Run manually or with Jenkins
LTTng Kernel Analysis Core Tests

1.12 Plug-in Run manually or with Jenkins
LTTng Kernel Analysis Ul Tests

1.13 Plug-in Run manually or with Jenkins
LTTng Kernel Ul SWTBot Tests

1.14 Plug-in Run manually or with Jenkins
LTTng Userspace Tracer Analysis

1.15 Core Test Plug-in Run manually or with Jenkins
LTTng Userspace Tracer Analysis

1.16 Ul Test Plug-in Run manually or with Jenkins
GDB Tracepoint Analysis Core

1.17 Tests Plug-in Run manually or with Jenkins
GDB Tracepoint Analysis Ul Tests

1.18 Plug-in Run manually or with Jenkins

Verification

All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed

All test cases passed
All test cases passed
All test cases passed

All test cases passed
All test cases passed

All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed

All test cases passed

Fail

To Do

Comment

[ 0 o

Pass
Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment



Target:

Step

ey

N

44

4.4

4.5
4.6
4.7

(%]

6.4

6.5

7

Section
TMF - EventsEditor

Test Case

Preparation
Preparation step 1

Trace bookmarks

Pass

Action

Open and reset LTTng Kernel perspective

Moved to sheet "BookmarksView"

Experiment bookmarks Moved to sheet "BookmarksView"

Filter

Filter

Cancel filter

Un-filter
Filter & Search
Search &Filter

Time Synchronization
Mouse synchronization
Key synchronization

Search synchronization

In the filter bar, enter some regex

In the filter bar, enter some regex, then quickly press ESC
before filtering is done

In the filter bar, clear the regex, or press DEL while table has

focus

In the filter bar, enter some regex; likewise in the search bar
In the search bar, enter some regex; likewise in the filter bar

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp,
PageDown, Home, End

In the search bar, enter some regex, then search again with

Enter/Shift-Enter

In any other view that supports time synchronization, select a

External synchronization time.

Range selection

Event Synchronization

Open trace

Mouse synchronization

Key synchronization

Search synchronization

Select an event with left button, press shift key and click select

another event

Open an LTTng CTF Kernel trace

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp,
PageDown, Home, End

In the search bar, enter some regex, then search again with

Enter/Shift-Enter

In any other view that supports time synchronization, select a
time. The selected event in the editor is updated. Then give

External synchronization Ffocus back to the editor.

Source Code / Model
Lookup

Fail

Verification

LTTng Kernel perspective opens with correct views.

Only events matching regex are displayed. Top and
bottom filter status rows update while filtering is
ongoing. When filtering is done, status rows show
number of matching events.

Only some events matching regex are displayed. Status
rows show partial number of matching events, with
different 'stop' icon.

All events are displayed. Selected event remains
selected and visible. Status rows are removed.

Events are filtered and highlighted accordingly
Events are filtered and highlighted accordingly

Other views are synchronized to the selected event's
time

Other views are synchronized to the selected event's
time

Other views are synchronized to the selected event's
time

The Ffirst event at or following the selected time is
selected and visible.

Range of events are highlighted. Selection range is
updated in other views that support range selection

Verify that an editor is opened showing LTTng Kernel
specific columns. Views are updated with the new
trace.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

Type

To Do

Comment

[ o i

Manual

Manual

Manual

Manual
SWTBot
SWTBot

Manual

Manual

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

Manual

Pass

Pass

Pass

Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

When opening a garbage file, it passes as BTF



71

7.2

7.3

7.4

8.1

8.2

9.1

8.2

83

Preparation

Open call site

Open call site (no source
code

Open model URI

Export to text

Export CTF trace

Export Other Trace

Swap Columns and
Change Fonts

Swap columns in events

table

Change fonts

Reset fonts

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Unzip traces/c_project_callsite.zip and
traces/callsite.zip to your local disk.

3) Import demo C project to the Eclipse workspace of zip
file c_project_callsite.zip

4) Import the test trace of zip Ffile callsite.zip to a tracing
project.

Select trace type "Generic CTF Trace" and open the trace

1) select event in table
2) click right mouse button
3) select "Open Source Code" menu item

1) Close source code project

2) select event in table

3) click right mouse button

4) select "Open Source Code" menu item

1) select event in table (e.g. 1st event)
2) click right mouse button
3) select "Open Model Element" menu item

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Export To Text" menu item
4) Enter a file name and location

5) Press OK

1) Open a trace other than CTF trace
2) Click right mouse button

3) Select "Export To Text" menu item
4) Enter a file name and location

5) Press OK

1) Open a trace
2) Drag a column

1) Open the preferences

2) select new font for trace types
3) press apply
4) verify that the font changed

1) Open the preferences

2) Reset the font settings

3) Press apply

4) verify that the font changed

Verify that correct source code file and line number is
opened Manual

Since the source code is not available the no source
code file is opened. Instead a error dialog is opened
(with title "FileNotFoundException") Manual

Since the model is not available the model element is
not shown. Instead a error dialog is opened (with title
"FileNotFoundException") Manual

Make sure that a progress monitor dialog is opened

during the export. After finishing make sure that the

text file exists and it contains the events stored in the

file. Verify that the columns are printed as shown in the

events table and that they are separated by tab

character. Manual

Make sure that a progress monitor dialog is opened

during the export. After finishing make sure that the

text file exists and it contains the events stored in the

file. Verify that the columns are printed as shown in the

events table and that they are separated by tab

character. Manual

Covered by SWTBot tests SWTBot

Covered by SWTBot tests SWTBot

Covered by SWTBot tests SWTBot




Section
TMF - Project View

Target: Ubuntu 14.10 64 bit

Step

1.1
1.2

2.1
22
2.3

31
3.2

3.10

3.1

3.12

Test Case

Preparation
Step 1
Step 2

Project Creation
New Project Wizard
Create project
Project structure

Traces Folder

Preparation
Traces Folder menu
Trace Import Wizard

Import single custom text trace
(link to workspace)

Import Single custom XML trace
(link to workspace)

Import LTTng Kernel CTF trace
(link to workspace)

Rename + copy import

Overwrite + copy import

Skip

Default overwrite

Import unrecognized
Import unrecognized (ignore)

Preparation

Import CTF trace by selection
metadata file only

Preparation

Pass

Action

Open LTTng Kernel perspective
Open Navigator View (used for independent verification)

Open New Tracing Project Wizard
Specify a project name and finish
Open the new Tracing project

1) Download traces.zip (if necessary) and unzip into a local
directory ${local|

2) Import Custom Text and XML parsers
(ExampleCustomXmlParser.xml,
ExampleCustomTxtParser.xml) from directory
traces/customParsers into your workspace from the
Manage Custom Parsers dialog.

Select the Traces folder and open its context menu
Select Import

1) Browse to directory ${local}/traces/import/

2) Select trace ExampleCustomTxt.log

3) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning" and
select "Create Links to workspace" and

4) press Finish

redo 3.1-3.3 but this time select ExampleCustomXml.xml

redo 3.1-3.3 but this time select directory kernel-overlap-
testing/

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"

When dialog box appear select Rename

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"

When dialog box appear select Overwrite

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace"

When dialog box appear select Skip

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace" and select "Overwrite existing without warning”

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) Select trace unrecognized.log

4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning" and
select "Create Links to workspace" and

5) press Finish

redo 3.10, however unselect "Import unrecognized traces"

Delete all traces in project - Right mouse click on Traces
folder and select "Clear"

Redo 3.5, However only select metadata file instead of
directory trace

Delete all traces in project

Fail

Verification

LTTng perspective opens with correct views
Navigator View opens

Tracing Project Wizard opens
Tracing project appears in Project Explorer/Navigator
Project contains Experiments and Traces folders

Correct menu opens (Import, Refresh)
Trace Import Wizard appears

Imported trace appear in Traces Folder and the Trace
Type Tmf Generic is set. Make sure trace can be opened

Imported trace appear in Traces Folder and the Trace
Type "Custom XML log" is set. Make sure that trace can
be opened

Imported trace appear in Traces Folder and the Trace
Type "LTTng Kernel" is set. Make sure that trace can be
opened

Traces are imported with new name that has a suffix (2)
at the end. Make sure that imported traces are copied
to the project.

Existing traces are deleted and new traces are
imported. Make sure that imported traces are copied to
the project and can be opened

Make sure that no new trace is imported

Make sure that no dialog box appears (for renaming,
overwriting, skipping) and existing traces are
overwritten). Make sure trace can be opened

unrecognized.log is imported with trace type unknown.
The default text file icon is displayed. The trace, when
opened, is displayed in the text editor.

unrecognized.log is not imported
Imported trace appear in Traces Folder and the Trace

Type "LTTng Kernel" is set. Make sure that trace can be
opened

Type

SWTBot
SWTBot

SWTBot
SWTBot
SWTBot

SWTBot
SWTBot

SWTBot

Manual

SWTBot

Manual

Manual

Manual

SWTBot

Manual

Manual

Manual

To Do

Pass
Pass

Pass
Pass
Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment
8

Comment

Either the text editor will open or the system editor, depending on the file associations in your installation



3.13

3.14

3.15

3.16

3.17

3.18

3.19

3.20

Recursive import with auto-
detection (Rename All)

Preparation

Recursive import with auto-
detection (Overwrite All)

Preparation

Recursive import with auto-
detection (Skip All)

Preparation

Recursive import with auto-

detection (test rename, overwrite

and skip)
Preparation

Recursive import with specific
trace type 1 (Skip All)

Preparation

Recursive import with specific
trace type 2 (Skip All)

Preparation

Recursive import with specific
trace type 3 (Skip All)

Preparation

Recursive import with specific
trace type 4 (Skip All)

Preparation

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve
Folder Structure"

5) press Finish

6) When dialog appears select "Rename All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve
Folder Structure"

5) press Finish

6) When dialog appears select Overwrite All"

Delete all traces in project

1) Open Import wizard gsee 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning" and
select "Create Links to workspace" and

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve
Folder Structure"

5) press Finish

6) When dialog appears select "Rename"

7) When dialog appears select "Overwrite"

8) When dialog appears select "Skip"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Generic CTF Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"and

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng Kernel Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "LTTng UST Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

All Traces are imported with respective trace type set.
Traces with name clashes are imported with suffix (2).
1 trace (unrecognized.log) is imported with trace type
unknown. Make sure that traces can be opened which
have a trace type set. The unknown trace type should

open with the text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are overwritten . 1 trace
(unrecognized.log) is imported with trace type
unknown. Make sure that traces can be opened which
have a trace type set. The unknown trace type should
open with the text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are not imported. 1 trace
(unrecognized.log) is imported with trace type
unknown. The unknown trace type should open with
the text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are either renamed,
overwritten or skipped as per dialog action. Make sure
that traces can be opened which have trace type set.
Tge unknown trace type should open with the text
editor.

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

4 CTF traces are imported with trace type "Generic CTF
Trace" . Make sure that these traces can be opened

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

One LTTng Kernel trace is imported with trace type
"LTTng Kernel Trace". Make sure that this trace can be
opened.

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

3 LTTng UST traces are imported with trace type
"LTTng UST Trace". Make sure that these traces can be
opened.

All text files in directories are imported as trace and
trace type "Tmf Generic" is set. Note that trace type
validation only checks for file exists and that file is not

a directory. Make sure that these traces can be opened.

However traces with wrong trace type won't show any
events in the table.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual



3.21

3.22

3.23

3.24

3.25

3.26

3.27

3.28
3.29

3.30

3.31

3.32

3.33

3.34

3.35

3.36

3.37

Import CTF trace by selection
metadata file only

Import to default project

Import wizard with no project
selected

Preparation

Redo 3.5, However only select metadata file instead of
directory trace

1) Delete project "Tracing"
2) Import a trace using import wizard (File > Import... >
Tracing > Trace Import)

Open import wizard while not having a project seleted
Delete all traces in project
D&D a few LTTng traces from another Tracing project's

Drag and Drop from other Tracing Traces folder

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop of trace with
existing name

Drag and Drop of trace with
existing name (2nd time)

Import destination
Preparation

Recursive import with preserved
folder structure

Recursive import with preserved
folder structure (Skip All)

Recursive import with preserved
folder structure (Rename All)

Preparation

Delete with mixed selection of
traces and folders

Delete multiple folders

Clear single Traces folder

Clear multiple Traces folder
Preparation

Import from archive, preserve
folder structure

Preparation

D&D a few files from a non-Tracing project

D&D a few files from an external file manager

2) D&D a trace with name of an existing trace into traces
older
2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same destination
folder
Open Import wizard

Delete all traces in project

13 Open Import wizard gsee 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite

existing without warning", select "Create Links to workspace"

and select "Preserve Folder Structure"
5) press Finish

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite

existing without warning", select "Create Links to workspace"

and select "Preserve Folder Structure"
5) press Finish
6) When dialog appears select "Skip All"

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite

existing without warning", select "Create Links to workspace"

and select "Preserve Folder Structure"
5) press Finish
6) When dialog appears select "Rename All"

Delete all traces in project

1) Create a trace folder under the "Traces" folder

2) Import 2 traces under the folder

3) Open one of the traces.

4) Select the trace folder and both traces in the Project
Explorer view

5) Right-click, Delete. Click OK.

1) Create 2 trace folders under the "Traces" folder
2) Import a trace in each folder

3) Select both trace folders

4) Right-click delete

1) Add a few folders and traces under the Traces folder
2) Right-click on the Traces folder, Clear. Click OK.

1) Create 2 trace projects, both containing a few traces.
2) Select both Traces folder
3) Right-click on one of the trace folders, Clear. Click OK.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory

4) Select trace type "Automatic”, unselect "Overwrite existing

without warning" and select "Preserve Folder Structure"
5) press Finish

Delete all traces in project

CTF trace is imported with correct trace type set. Trace
can be opened.

Make sure the project with name Tracing is created and
trace is imported to that project.

Verify that "Into Folder" points to project
Tracing/Traces. Also make sure that project Tracing was
create:

Selected traces are added to the Traces folder with
proper icon. Trace can be opened.

Selected traces are added to the Traces folder with
dgfault icon. Files can be opened wit the default
editor.

Selected traces are added to the Traces folder with
default icon. For actual traces Trace type is detected
automatically. Trace can be opened, For non traces the
files are added with default icon and they can be
opened with the default editor.

Verify that trace is added into the traces folder with
the trace name of the orignal trace plus a suffix 2

Verify that trace is added into the traces folder with
the trace name of the orignal trace plus a suffix 3

Verify that "Into Folder" text box cannot be updated

All Traces are imported with respective trace type set.
The folder "clashes" is imported with its traces inside.
Make sure that traces can be opened which have a
trace type set.

The wizard should finish quickly as no trace will be
imported. Make sure that traces can be opened which
have a trace type set.

All Traces are imported with respective trace type set
with suffix (2). The folder "clashes" is imported with its
traces inside. Make sure that traces can be opened
which have a trace type set.

A dialog should ask the user to confirm deletion of the
selected elements. Clicking OK should remove all that
was selected. The editor should be closed
automatically.

A dialog should ask the user to confirm deletion of the
folders. Clicking OK should remove all that was
selected.

A dialog should ask the user to confirm the clear of the
fotder, glicking OK should everything under all that was
selected.

A dialog should ask the user to confirm the clear of the
folders. Clicking OK should everything under all that
was selected.

All the files get imported under their respective
folders. The CTF traces can be opened (kernel-overlap-
testing, simple_server...)
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3.38

3.39

4.1
4.2
4.3
4.4
4.5
4.6
4.7

4.8

4.9

5.1
52

6.1
6.2
6.3
6.4
6.5
6.6
6.7
6.8
6.9

6.10

6.11

71
7.2

73

7.4

7.5

7.6

7.7

7.8

79

7.10

7.1

Import from archive, no preserve
folder structure

Preparation

Import from archive, rename all

Trace

Trace menu

Open trace

Copy trace

Rename trace

Delete trace

Open Trace (Accelerator)
Delete Trace (Accelerator)

Open Trace (double click)

Open Trace (already open)

Experiments Folder

Experiments menu
Create experiment

Experiment

Experiment menu

Select Traces dialog

Select traces

Open experiment

Copy experiment

Rename experiment

Delete experiment

Open Experiment (Accelerator)
Delete Experiment (Accelerator)

Delete Experiment (open
experiment;

Select Traces while Experiment is
open

Experiment Traces
Trace menu
Open trace

Remove trace

Drag and Drop from Traces

Drag and Drop from other Tracing
Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop from external
(non-traces)

Drag and Drop of trace with
existing name

Drag and Drop of trace with
existing name (2nd time)

Drag and Drop of trace while
Experiment is open

1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory

All the files get imported. The CTF traces can be
opened (kernel-overlap-testing, simple_server...). The

4) Select trace type "Automatic", unselect "Overwrite existing traces with name clashes are added with the trace

without warning" and unselect "Preserve Folder Structure”
Sg press Finish
6) Select Rename All when dialog comes up.

DO NOT delete all traces in project

1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory

name of the orignal trace plus a suffix 2
(ExampleCustom*, kernel-overlap-testing,
simple_server...).

4) Select trace type "Automatic”, unselect "Overwrite existing All the files get imported. The CTF traces can be

without warning" and unselect "Preserve Folder Structure”
5) press Finish
6) Select Rename All when dialog comes up.

Select an LTTng trace and open its context menu

Select the Open menu

Select the Copy menu and provide a new name. Open.
Select the Rename menu and provide a new name. Reopen.
Select the Delete menu and confirm deletion

Select trace and press Enter

Select trace and press Delete and confirm deletion

Double-click a trace

Open two traces. Open the first trace again.

Select the Experiments folder and open it context menu
Select the New menu and provide experiment name

Select an experiment and open its context menu

Select the Select Traces menu

Select a few LTTng traces and finish

Select the Open menu

Select the Copy menu and provide a new name. Open.
Select the Rename menu and provide a new name. Open.
Select the Delete menu and confirm deletion

Select an Experiment and press Enter

Select an Experiment and press Delete and confirm deletion

Open an experiment, select expereiment and press Delete
and confirm deletion

Open an experiment and select an additional trace (see 6.3)

Select an LTTng trace and open its context menu

Select the Open menu

Open Experiment, select the Remove menu and confirm
removal

D&D a few LTTng traces from the Traces directory

D&D a few LTTng traces from another Tracing project's
Traces folder

D&D a few traces from a non-Tracing project

D&D a few traces from an external file manager

D&D a few files (non-traces) from an external file manager

opened (kernel-overlap-testing, simple_server...). The
traces with name clashed are added with the trace
name of the orignal trace plus a suffix 2 or 3 or 4.

Correct menu opens (Open, Copy, Rename, ...)
Trace is opened and views are populated
Trace is replicated under the new name

Trace is renamed. The trace editor is closed.
Trace is deleted. The trace editor is closed.
Trace is opened

Trace is deleted. The trace editor is closed.

Trace is opened

The first trace editor is simply brought to front.

Correct menu opens (New, Import XML Analysis,
Refresh)

Experiment appears under folder, no traces yet

Correct menu opens (Select, Open, Copy, Rename, ...)
Select Traces dialog is open and populated w/ traces
Selected traces are imported in the experiment
Experiment is opened and views are populated
Experiment is replicated under the new name
Experiment is renamed

Experiment is deleted

Experiment is opened

Experiment is deleted

Experiment is closed and deleted

Experiment is closed and selected traces is imported to
the experiment

Correct menu opens w/ Copy disabled + Remove
Trace is opened and views are populated

Experiment is closed, trace is removed from
experiment

Selected traces are added to the experiment with
proper icon. Experiment can be opened.

Selected traces are added to the experiment + Traces
with proper icon. Experiment can be opened.
Selected traces are added to the experiment + Traces
with proper icon. Experiment can be opened.

Selected traces are added to the experiment + Traces
with proper icon. Experiment cannot be opened.

Selected traces are added to the experiment + Traces
with proper icon. Experiment can be opened.

1) D&D a trace with name of an existing trace into experiment Verify that trace is added into the traces folder and

folder
2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same destination
folder

Open an experiment and D&D a trace from the Traces
directory (see 7.4

experiment folder with the trace name of the orignal
trace plus a suffix 2

Verify that trace is added into the traces folder and
experiemnt folder with the trace name of the orignal
trace plus a suffix 3

Experiment is closed and selected traces is imported to
the experiment

SWTBot
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Failed in 3.0, 3.1, 3.2, TC 0.1 When copying a renamed experiment the orignal named experiment is rec



8.1
8.2
83
8.4

8.5

9.1

9.2

9.3

9.4

10

10.1
10.2
10.3

1

1.1

11.2

11.3

11.4

11.5

11.6

11.7

11.8

11.9

11.10

11.11

11.12

11.13

12

121

Propagation
Preparation

Rename propagation
Delete propagation
Propagate trace type 1

Propagate trace type 2

Properties View
Synchronization

Trace synchronization

Other trace nodes
synchronization

Check trace properties
Check trace properties -
experiment

Trace Type Selection
Preparation
Trace properties

Trace filtering

Supplementary Files

Preparation

Create Supplementary File (State

History File) from trace

Trace Context sensitive menu

Delete Supplementary Files

Action

Select and delete State History

File

Create Su[pplementary File (State
e) from experiment

History Fil

Delete Supplementary Files

Action

Sellect and delete State History
File

Select and delete multiple State

History Ffiles

Delete Trace

Delete Experiment

Delete Experiment Trace

Delete Supplementary Files

Action while trace is open

Link With Editor

Preparation

Copy experiment

In Traces folder, rename a trace showing in both experiments
In Traces folder, delete a trace showing in both experiments
Add a trace to 2 experiments. Change its type from Traces

Add a trace to 2 experiments. Change its type from one of
the experiments

Select a trace under a Traces folder in Project Explorer view.
Repeat with trace under an Experiment.

Select a Traces folder, Experiments folder, or an experiment
in Project Explorer view.

Open an LTTng kernel trace, click on the trace, check the new
properties view.

Open an experiment which containes LTTng kernel traces,
click on the experiment, check the new properties view.

Import an file with unrecognized trace type
($eiocal)/traces/import/unrecognized4log

Select the trace and open the Properties View
Select an experiment and open Select Traces dialog

1) In Project Explorer remove filter for hidden resources
(Coolbar menu > Customize View... > unselect '.* resources)
2) Create Experiment with 2 LTTng CTF tracesin it

Open a LTTng CTF trace and wait for indexing to finish
a) Select trace under Folder Traces and click right mouse
button

b) Redo test: Select trace under Experiment Folder

) Redo test: Select Experiment

1) Select trace and click right mouse buFton

2) Select 'Delete Supplementary Files...

Select <trace name>/StateHistory.ht file and click on 'Ok’

Open Experiment with 2 LTTng CTF traces

1) Select Experiment and click right mouse button
2) Select 'Delete Supplementary Files...'

Select one history file (<trace name>/StateHistory.ht) and
click on 'Ok’

1) Redo 11.2 and 11.6
2) Select both history files and click on 'Ok’

a) Redo 11.2 to create Supplementary File
b) Delete trace

a) redo 11.6 to create experiment and Supplementary File
b) delete Experiment

a) redo 11.6 to create experiment and Supplementary File
b) remove traces under Experiment

Open trace and then redo 11.4

1) In Project Explorer make sure that "Link with Editor"
button is selecte
2) Open multiple traces and experiments

Selected experiment is replicated

New name is propagated to both experiments
Selected trace is removed from both experiments
All occurences of that trace are updated

All occurences of that trace are updated

The Properties view is updated with the selected
trace's "Resource properties” Property and Value. The
"Info > type" property shows the selected trace
category and trace type name.

The Properties view is updated with the selected item's
Property and Value. For Experiment verify the "type"
property is set.

The "Trace properties” should be populated

The "Trace properties" should be populated for every
subtrace

Imported trace appear in Traces with default icon. File
is can be opened by default Editor (either Eclilpse text
or system editor depending on plug-ins installed)

Selected trace type is blank
Untyped trace does not appear in list

Verify that .tracing directory is shown under the project

Verify that StateHistory.ht is created under
.tracing/<trace name>/.

Verify that menu item 'Delete Supplementary Files..." is
shown in the context-sensitve menu

Verify that confirmation dialog box is opend and <trace
name>/StateHistory.ht is liste

Make sure that file .tracing/<trace
name>/StateHistory.ht is deleted from the project
explorer view

Verify that two StateHistory.ht files are created under
.tracing/<trace1 name>/ and ./tracing/<trace2 name>!
respectively. Also verify, that supplementatry folder for
the experiment ./tracing/<exp name>_exp is created.

Verify that confirmation dialog box is opend and shows
3 root entries:

<exp name>, <trace1 name> and <trace2 name>, with
their respective supplementary files below

Make sure that the selected file .tracing/<trace
name>/StateHistory.ht is deleted from the project
explorer view

Make sure that both history files are deleted under
.tracing/<trace1 name>/ and .tracing/<trace2 name>/
respectively

Verify that supplementary directory .tracing/<trace
name>/ is deleted.

Verify that supplementary File StateHistory.ht

.tracing/<trace1 name>/ and ./tracing/<trace2 name>/

are NOT deleted. Also verify that the supplementary

zolldergor the experiment ./tracing/exp_name_exp is
eleted.

Verify that supplementary File StateHistory.ht
.tracing/<trace1 name>/ and ./tracing/<trace2 name>/
are NOT deleted

Verify that trace is closed and supplementary files are
delete

Manual
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Manual
Manual

Manual

Manual

Manual

Manual
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Manual
Manual
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Manual

Manual
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N/A

New feature ... not implemented yet



12.2

123

12.4

12.5

12.6
13

131

13.2

133

13.4

13.5

13.6

137

13.8

13.9

13.10

13.11

13.12

13.13

13.14

13.15

13.16
14

141

14.2

14.3

Verify that after each selection the corresponding trace

Select trace/experiment in Editors Select several traces and experiments one after each other in or experiment element is selected in the Project

area

Select opened
traces/experiments in Project
Explorer

Preparation

Select trace/experiment in Editors Select several traces and experiments one after each other in

area

Select opened
traces/experiments in Project
Explorer

Trace Package Export Wizard

Preparation

Open the trace package export
wizar

Select Traces

Deselect/Select All

Trace element selection

Trace sub-element selection

Select/Deselect All

Archive file selection

Change export options, change
compression

Change export options, change
format

Change export options, change
format and compression

Finish the wizard

Overwrite

Verify formats

Verify content

Partial selection
Trace Package Import Wizard

Preparation

Open the trace package import
wizard

Project Selection

Editors area

Select several open traces and experiments one after each

other in Project Explorer

1) In Project Explorer make sure that "Link with Editor"

button is not selecte:

2) Open multiple traces and experiments (if not open)

Editors area

Select several open traces and experiments one after each

other in Project Explorer

1) Import 2 traces that generate supplementay files (trace2,

kernel_vm)

2) Open both traces, wait for the indexing to finish
2) Add bookmarks in the two traces

Click on “File”, “Export...

, “Tracing”,
and click Next

‘Trace Package Export”

On the left side, select the project in which the traces were
imported. Then on the right side, selected both traces.

With traces selected,

ress the Deselect All button. Then

press on the Select All button. Click Next.

Unselect the trace2 element

Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click Deselect All.

Then click Select All again.

1) Click on the Browse button.

2) Select a location on the filesystem

3) Enter the file name export.tar

Unselect the “Compress” checkbox.

Change to Zip format

Change to Tar format then select the Compress checkbox.

Click Finish

Open the wizard again and select the traces (step 13.2, 13.3).

Click Finish.

Open the wizard again and select the traces (step 13.2, 13.3).

This time, choose Zip format. Click Finish.

Open the tar.gz and the zip files in an archive manager.

Open the wizard again and select the traces (step 13.2, 13.3).
This time, unselect both Supplementary files subtrees. Click

Finish.

Create an empty tracin? project. Make sure you have
T

export.tar.gz available

om the Trace Package Export Wizard

(13) test case, which should include everything includin
trace files, supplementary files and export-manifest.xml.

Click on “File”, “Import...
and click Next

, “Tracing

Trace Package Import”

Click the Select button. Choose the previously created

project.

Explorer

Verify that after each selection the corresponding trace
or experiment is brought to the top in the Editors area

Verify that selection in Project Explorer doesn't change

Verify that Editor in focus is not changed

A wizard should appear with a list of projects and
traces to select. Next button should be disabled.

Next should be become enabled when the first trace is
Z@legtleg. If all traces are unselected, the Next button is
isabled.

Next should become disabled after Deselect All,
enabled after Select All.

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to a
lower number.

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to 0. The
Next button is disabled.

When Select Allis clicked, all the tree elements are

selected, the approximate size increases. When

Deselect Allis clicked, all the tree elements are
eselected and the approximate size decreases.

A file chooser dlalog comes up. Whe the destination file
is entered, the “To archive file” is filed witl
export. tar. gz. The Finish button should be enabled.

The name of the archive file changes to export.tar
The name of the archive file changes to export.zip

The name of the archive file changes to export.tar.gz

A progress bar should appear at the bottom the the
dialog and it should disappear upon completion. The
export.tar.gz file should be created on the file system.

The Archive file name should be remembered and
already filled. A dialog should prompt the user to
overwrite. Answering No should keep the wizard
opened. Answering Yes should re-export the archive
and close the wizard.

The export.zip file should be created on the file system

In both archives, verify that it contains:

1) A trace folder for each trace containing all the trace

files (excluding supplementary files;

I%)l A .tracing folder containing all the supplementary
iles

3) An export-manifest.xml file listing the trace files,

supplementary files and bookmarks

Verify that the exported archive contains:
In both archives, verify that it contains:
1) A Traces folder containing all the trace Ffiles
excludlng sup#)lementary files)

2) No .tracing folder
3) An export-manifest.xml file listing the trace files and
bookmarks

The Ffirst page of the wizard should appear (Choose
content to import)

The Into project field gets filled with the selected
project name.
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14.4

14.5
14.6
14.7

14.8

14.9

14.10
14.11

14.12

14.13
15

15.1

15.2

15.3

15.4

15.5

15.6

15.7

15.8

15.9

15.10

15.11

Archive file selection

Deselect/Select All
Trace element selection
Trace sub-element selection

Select/Deselect All

Finish the wizard

Supplementary Files
Bookmarks

Open from bookmark

Overwrite
Time Offsetting

Preparation

Apply time offset dialog - trace
selection

Apply time offset dialog - folder
selection

Apply time offset dialog -
experiment selection

Apply time offset dialog - Basic

Apply time offset dialog -
cumulative offset

Clear time offset

Apply time offset dialog -
Advanced mode

Apply time offset dialog -
Advanced mode - compute from
selection

Apply time offset dialog -
Advanced mode - compute from
entered values

Clear time offset with opened
traces

1) Click on the Browse button.
2) Browse for export.tar.gz on the file system

With traces selected, press the Deselect All button. Then
press on the Select All button.

Unselect the trace2 element
Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click Deselect All.
Then click Select All again.

Click Finish

Right-click on trace2 in Project Explorer
Open the Bookmarks view

Double click on one of the bookmarks

Open the wizard again (step 13.2) and select the archive file
(step 13.4). Click Finish.

Open Project Explorer view and Properties view. Create an
empty tracing project. Import two different traces to the
project. Open the traces and note their start time. Close the
traces.

Select both trace elements in the Project Explorer view.
Right-click and select Apply Time Offset...

Select the Traces folder element in the Project Explorer view.
Right-click and select Apply Time Offset...

Create an experiment with both traces. Select the
experiment element in the Project Explorer view. Right-click
and select Apply Time Offset...

Select a trace element in the Project Explorer view. Right-
click and select Apply Time Offset... In the Offset in seconds
column, enter a time with seconds and decimals. Click OK.
Open the trace.

Select the same trace element in the Project Explorer view.
Right-click and select Apply Time Offset... In the Offset in
seconds column, enter a time with seconds and decimals.
Click OK. Open the trace.

Select the trace element in the Project Explorer view. Right-
cLick and select Clear time offset. Click OK to confirm. Open
the trace.

Open one trace and close the other trace. Select both trace
elements in the Project Explorer view. Right-click and select
Apply Time Offset... Choose the Advanced radio button.

trace. Click OK. Open both traces.

Select the first trace element in the Project Explorer view.
Right-click and select Apply Time Offset... Choose the
Advanced radio button. Double-click the trace name to open
it. Select the Reference time cell and copy the start time.
Select the Target time and paste the value. Edit both values
to different times. Click the button in the trace row. Click OK.
Open the trace.

Open both traces. Select both trace elements in the Project
Explorer view. Right-click and select Clear time offset. Click
OK to confirm. Open the traces.

Finish should be become enabled when the first trace is
selected. If all traces are unselected, the Next button is

disabled.

Finish should become disabled after Deselect All,

enabled after Select All.

All elements in the trace tree are unselected.
All elements in the trace tree are unselected.

When Select All is clicked, all the tree elements are
selected. When Deselect Allis clicked, all the tree

elements are deselected..

A progress bar should appear at the bottom the the
dialog and it should disappear upon completion. The
two traces should appear under the project in Project

Explorer

Delete Supplementary files appears in the content

menu

Bookmarks appear in the list for the imported traces

The corresponding trace opens at the bookmarked
event. Bookmarks are displayed in the event table.

A dialog should prompt the user to overwrite for each
trace. Answering Yes to All should overwrite without

prompting again.

The Apply time offset dialog opens in Basic mode. The
Trace name show both traces and the Offset in seconds

is blank.

The Apply time offset dialog opens in Basic mode. The
Trace name show both traces and the Offset in seconds

is blank.

The Apply time offset dialog opens in Basic mode. The
Trace name show both traces and the Offset in seconds

is blank.

The timestamps in the trace are all offset by the
entered value. The Properties view shows the 'time

offset' with the entered value.

The timestamps in the trace are all offset by the
cumulative sum of the previous and current entered
value. The Properties view shows the 'time offset' with

the cumulative value.

The timestamps in the trace are back to their original
values. The Properties view shows the 'time offset' as

lank.

The Apply time offset dialog opens and is switched to
Advanced mode. The Trace name show both traces and
the Offset in seconds is blank. The Reference time for
the opened trace is set to its start time.

Both traces are open. Selecting an event updates the
Reference time for the selected trace, and updates the
Target time for all traces. Pressing the button
computes the Offset in seconds as the difference
between Target time and Reference time for that row.
The trace which has a computed offset is closed when
Double-click the second trace to open it. Select an event in its the OK button is pressed. After reopening, the two
trace editor. Select the first trace editor. Select an event in its previously selected events now have the same

trace editor. Click the button in the dialog row of the second timestamp. The Properties view shows the 'time offset'

with the computed value.

The trace is opened. The Reference time is set to the
trace start time. The Reference time and Target time
can be copied, pasted, and edited. Pressing the button
computes the Offset based on the current time values.
The trace is closed with the OK button is pressed. After
reopening, the timestamps in the trace are offset
according to the computed value. The Properties view
shows the 'time offset’ with the computed value.

The opened traces are closed when the OK button is
pressed. After reopening, the timestamps in the traces
are back to their original values. The Properties view
shows the 'time offset' as blank.
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Column width of calculated offset is very small in GTK3



Section Comment
TMF - BookmarksView

Target: Ubuntu 14.10 64 bit

Type To Do

Test Case Verification Comment

1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. Manual Pass
2 Trace bookmarks
2.1 Show Bookmarks View Select Bookmarks view (bottom folder) Bookmaks view is shown Manual Pass
Views are populated. Verify that a Kernel events editor is
22 Open trace Open an LTTng CTF Kernel trace opened showing LTTng Kernel specific columns Manual Pass
Add a bookmark, by
a) double-clicking on the left margin next to an event Make sure that bookmark icon is shown on left site of the
b) right-clicking the margin and select Add bookmark.... event row and is added to the Bookmarks view with relevant
¢) using the Edit > Add bookmark... menu. information (i.e. Description entered and correct trace
2.3 Add Trace Bookmark Enter the bookmark description in dialog box resource) Manual Pass No Edit menu in Trace Compass RCP
Scroll within event table so that bookmark is not visible anymore and Make sure that event with bookmark is selected and visible in
2.4 Open Trace Bookmark (1)  then double-click on bookmark in Bookmarks View event table Manual Pass
Open another trace #2 and then double-click on bookmark in Make sure that correct trace #1 is brought to top and correct
2.5 Open Trace Bookmark (2)  Bookmarks view event with bookmark is selected in events table Manual Pass
Close the trace #1 and then double-click on bookmark in Bookmarks Make sure that correct trace #1 is opened and correct event
2.6 Open Trace Bookmark (3)  view with bookmark is selected in events table Manual Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from Select bookmarks icon in event table right-click on icon and select  and corresponding bookmark is removed from the Bookmarks
2.7 table) "Remove Bookmark" view Manual Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from and corresponding bookmark is removed from the Bookmarks
2.8 table) Double-clicking bookmarks icon in event table. view Manual Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from Add a bookmark (see 2.4), then select bookmark in Bookmarks view, and corresponding Bookmark is removed from the Bookmarks
29 Bookmarks view) right mouse click and select "Delete". Confirm the deletion. view Manual Pass
3 Experiment bookmarks
Create Experiment with 2 LTTng CTF Kernel traces in it and open  Verify that an Events editor is opened showing LTTng Kernel
3.1 Create and open experiment experiment specific columns Manual Pass
Add a bookmark, by
a) double-clicking on the left margin next to an event Make sure that bookmark icon is shown on left site of the
b) right-clicking the margin and select Add bookmark.... event row and is added to the Bookmarks view with relevant
¢) using the Edit > Add bookmark... menu. information (i.e. Description entered and correct experiment
32 Add Experiment Bookmark ~ Enter the bookmark description in dialog box resource) Manual Pass

Open Experiment Bookmark Scroll within event table so that bookmark is not visible anymore and Make sure that event with bookmark is selected and visible in

33 (1) then double-click on bookmark in Bookmarks View event table Manual Pass
Open Experiment Bookmark Open another trace #2 and then double-click on bookmark in Make sure that correct experiment #1 is brought to top and
34 2) Bookmarks view correct event with bookmark is selected in events table Manual Pass
Open Experiment Bookmark Close the experiment #1 and then double-click on bookmark in Make sure that correct experiment #1 is opened and correct
3.5 3) Bookmarks view event with bookmark is selected in events table Manual Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from Select bookmarks icon in Events view, right-click on icon and select and corresponding bookmark is removed from the Bookmarks
3.6 table) "Remove Bookmark" view Manual Pass

Make sure that bookmark icon is removed from event table
Delete Bookmark (from Add a bookmark (see 6.4), then select bookmark in Bookmarks view, and corresponding Bookmark is removed from the Bookmarks
37 Bookmarks view) right mouse click and select "Delete". Confirm the deletion. view Manual Pass



Section Pass Fail ToDo Comment

TME - Filters View 12 L

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

Open a trace to be

1 filtered Trace is opened SWTBot SWTBot Pass

2 Open filter view Filter view is opened SWTBot SWTBot Pass
Create a filter on event  The filterview contains a filter on the event type and the

3 type and timestamp timestamp SWTBot SWTBot Pass

3.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass

Create a filter on the
timestamp oring field

4 values Create the filter SWTBot SWTBot Pass
4.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with equals
5 node Create the filter SWTBot SWTBot Pass
5.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with
6 matches node Create the filter SWTBot SWTBot Pass
6.1 Apply that filter A subset of the events pass SWTBot SWTBot Pass
Create a filter with
7 contains node Create the filter SWTBot SWTBot Pass

71 Apply that filter A subset of the events pass SWTBot SWTBot Pass



Section Pass Fail ToDo Comment

TMF - Colors View 6 -“ 0

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

1 Open a test trace a trace is visible in the events editor SWTBot SWTBot Pass

2 Open the colors view the view is visible SWTBot SWTBot Pass
Select a color and a filter, the matching events should update

3 Select a color and a filter their colors (background and foreground) to the new ones SWTBot SWTBot Pass

4 Add multiple colors Click on add 4 times, four colors should be displayed SWTBot SWTBot Pass
Change the color By clicking on up and down, the order of the displayed colors

5 priorities should change SWTBot SWTBot Pass

6 Delete all the colors The color filters should disappear. SWTBot SWTBot Pass



Section Pass
TMF - Histogram View 50

Target: Ubuntu 14.10 64 bit

Step

1.1
1.2

2.1
2.2
2.3

3.10
5.1

5.2

5.4
5.5

Test Case Action

Preparation

Step 1 Open and reset LTTng Kernel perspective

Step 2 Open an LTTng trace

Manage View

Close view Close the Histogram View

Open view Window > Show View > Other > Tracing > Histogram
Resize Resize the Histogram View width-wise

Full Trace Histogram

Single selection Select timestamp with left-click
Select time range with shift-left-click, shift-left-drag or left-
Range selection drag
Drag the zoom window left/right with ctrl-left-drag or
Drag zoom window middle-drag
Move zoom window Move the zoom window with ctrl-left-click or middle-click
Set zoom window Set a new zoom window with right-drag
Zoom in/out Zoom in/out with mouse wheel up/down
Arrow keys Move the current event using left/right arrow keys
Home/End keys Press Home/End key
With a trace containing lost events, click the "Hide lost
Lost events events" toolbar icon. Click it again.
Zoom in/out (key) Zoom infout with +/- key
Time Range Histogram
Single selection Select timestamp with left-click
Select time range with shift-left-click, shift-left-drag or left-
Range selection drag
Drag the zoom window left/right with ctrl-left-drag or
Drag zoom window middle-drag
Zoom in/out Zoom in/out with mouse wheel up/down
Arrow keys Move the current event using left/right arrow keys
Home/End keys Press Home/End key
With a trace containing lost events, click the "Hide lost
Lost events events" toolbar icon. Click it again.
Zoom in/out (key) Zoom infout with +/- key
Selection Start/End
Set selection start Enter a TS within the full range in Selection Start widget
Set selection end Enter a TS within the full range in Selection End widget
Select the link icon. Enter a TS within the full range in
Set selection (linked) Selection Start widget

Enter a TS before the full range start in Selection Start
Set invalid selection start widget

Set invalid selection end Enter a TS after the full range end in Selection End widget

Verification

LTTng Kernel perspective opens with correct views

Views are populated

Histogram View is removed from perspective
Histogram View is displayed and re-populated
Histograms are compressed/decompressed without loss

Selection Start/End + blue bars are updated
Selection Start/End + blue bars are updated

Zoom window is dragged, won't go beyond full range
Zoom window is centered on click, won't go beyond full

range

Zoom window is set, Window Span is updated, won't go

beyond histogram range

Zoom window is updated, Window Span is updated,
won't go below 2 ns, won't exceed full trace range

Selection (blue bar) moves to the previous/next non-

empty bucket

Selection Start/End moves to beginning/end of trace (i.e.
start time of last bucket is selected)

The lost events (red bars) are toggled on and off.

Zoom window is updated, Window Span is updated,
won't go below 2 ns, won't exceed full trace range

Selection Start/End + blue bars are updated

Selection Start/End + blue bars are updated

Zoom window is dragged, won't go beyond full range

Zoom window is updated, Window Span is updated,
won't go below 2 ns, won't exceed full trace range

Selection (blue bar) moves to the previous/next non-

empty bucket

Selection Start/End moves to beginning/end of time
range (i.e. start time of last bucket is selected)

The lost events (red bars) are toggled on and off.

Zoom window is updated, Window Span is updated,
won't go below 2 ns, won't exceed full trace range

Selection Start + blue bars are updated
Selection End + blue bars are updated
Selection Start/End + blue bars are updated

Selection Start + blue bar set to first event
Selection End + blue bar set to last event

Fail

To Do

Comment

| [ o s

SWTBot
SWTBot

Manual
Manual
Manual

Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual

Manual

Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual

Manual
Manual

Pass
Pass

Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Comment

arrow right doesn't work (Bug 468074) - fixed for Mars

arrow right doesn't work (Bug 468074) -> fixed - Fixed for Mars



6.1
6.2

6.3

71

7.2

73

7.4

8.1

8.2

8.3

8.4

9.1

9.2

9.3

9.4

10

10.1

10.2

10.3

10.4

10.5

Window Span
Set window span
Set large window span

Set invalid window span

Selected Timestamp
Synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Selection synchronization
(linked)

External synchronization

Selected Time Range
Synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Selection Start/End
synchronization

External synchronization

Zoom Window
synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Wwindow Span
synchronization

External synchronization

Multiple Trace
Synchronization

Preparation

Open multiple traces (no
overlap)

Change selected time and

range (no overlap)

Open multiple traces
(overlap)

Change selected time and

range (overlap)

Select other trace
(overlap)

Enter a span in Window Span widget
Enter an invalid span (too large) in Window Span widget

Enter an invalid span (too small, negative, not a number) in
Window Span widget

Click on the time range histogram. The time of the bucket at
the mouse position is selected.

Click on the full trace histogram. The time of the bucket at
the mouse position is selected.

Select the link icon. Enter a time within the full range in
Selection Start widget

In any other view that supports time synchronization, select a
time.

Select a time range in the small histogram (shift-left click,
left-drag or shift-left drag).

Select a time range in the full histogram (shift-left click, left-
drag, shift-left drag).

Enter a time within the full range in Selection Start/End
widget

In any other view that supports time range synchronization,
select a time range.

Select a zoom window in the small histogram (ctrl-left drag,
middle-drag, right-drag, mouse wheel up/down).

Select a zoom window in the full histogram (ctrl-left drag,
middle-click, middle-drag, right-drag, mouse wheel up/down).

Enter a new span in Window Span widget

In any other view that supports range synchronization, select
a new zoom window.

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time
Select a time and new range
Open multiple traces that overlap in time

Select a time and new range

Select different trace by clicking its editor tab

Both Histograms are updated accordingly
Span set to full range

Span set to previous value

Other views are synchronized to the selected time
Other views are synchronized to the selected time

Other views are synchronized to the selected time

Selection Start/End + blue bars in both histograms are
updated to the selected time

Verify that the selected time range shows in both
histograms, and in other views.

Verify that the selected time range shows in both
histograms, and in other views.

Other views are synchronized to the selected time range

Selection Start/End + blue bars in both histograms are
updated to the selected time range

Other views are synchronized to the new range
Other views are synchronized to the new range

Other views are synchronized to the new range

Window Span and both histograms are updated to the
new range

View shows the last opened trace

Selection Start/End, Window Span and both histograms
are updated to selected time and new range.

View shows the last opened trace

Selection Start/End, Window Span and both histograms
are updated to selected time and new range.

View is updated to show selected trace. Selection
Start/End, Window Span and both histograms are set to
the newly selected time and range.

Manual
Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass



The colors in both Histograms and toggled on and off.
With an experiment containing multiple traces opened, click When itis toggled off, the legend disappears at the
10.6  Trace coloring the "Activate trace coloring" toolbar icon. Click it again. bottom and only one color is used for non-lost events. Manual

10.7  Close all traces Close all trace editor tabs View is cleared. Manual



Section

TMF - Sequence Diagram

Target: Ubuntu 12.04 64 bit

Step

1

2.2

3.2

5

Test Case

Preparation

Open perspective

Open TMF Sequence
Diagram View

Create and open
experiment with
sequence diagram data

Manage View
Close view

Open view when
experiment/traces is
already loaded

Tooltip

Hover over interaction

Hover over interaction
after selection

Hover over time
compression bar

View Synchronization

Selection of interaction

Selection of event in
events table

Selection of new time
range

View Actions

Pass

Action

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2 )Use traces simple-server-thread1 and simple-server-

thread2 under traces/import/ for test cases below

Open and reset LTTng Kernel perspective

Use menu Window — Show View - Other ... - Tracing -
Sequence Diagram

1) Create Tracing Project
2) Create Experiment (SeqExp)

3) Import 2 traces simple-server-thread1 and simple-server-

thread2

4) Select trace type "Generic CTF Trace"
5) Add these 2 traces to experiment

6) Open (double-click on) the experiment

Close Sequence Diagram view
1) Close 'Sequence Diagram' View

2) load sequence diagram experiment
3) Open Sequence Diagram view

1) Goto to first page (no selection of any interaction or

lifeline) 2) Hover over first interaction (arrow or number)

1) Goto to first page
2) select first interaction
3) Hover over 3rd interaction

Hover over first element in time compression bar on the left

of the view

Select an interaction in the 'Sequence Diagram'

Select an sequence diagram event in the events table (type

SEND or RECEIVE)

Change time range in 'Histogram View'.

Fail

Verification

LTTng Kernel perspective opens with correct views:
Project Explorer, Control, Control Flow, Resources,
Statistics, Histogram, Properties, Bookmarks

Verify that 'Sequence Diagram' view is shown

Verify that sequence diagram was loaded. The
interaction show the signal numbers (Note that trace
doesn't contain strings for the interactions. A special
parse)r would be necessary to map signal number to
trace

Sequence Diagram View is removed from perspective

Verify that sequence diagram was loaded. Verify that
all 17 pages are loaded.

Verify that tooltip appears with content with
interaction name and time stamp (10000
14:58:00.740995147)

Verify that tooltip appears with content with
interaction names and time stamp delta between
selected interaction and interaction that was hovered
over (10001 - 10000 delta: 000.000 157 023)

Verify that tooltip appears with delta and graph to
show where delta is in relation to current configured
min max values. (delta: 000.000 3 480)

Verify that interaction is highlighted in 'Sequence
Diagram' view. Verify that in the events table the
corresponding event is selected. Verify that time
stamps matches

Verify that corresponding interaction is selected in the
'Sequence Diagram' view

Verify that the focus to the corresponding events of
the 'Sequence diagram' changes is changed.

To Do

Comment

ICENE

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Tooltip backgound is very dark and text is hard to read
on Ubuntu 13.10, 14.10 with default theme
https://bugs.eclipse.org/bugs/show_bug.cgi?id=45552
3

It's a bit unclear to me what this is supposed to do. |
think it means when the start of the range changes, it
should update the events shown in the sequence
diagram



5.1

52

53

5.4

5.5

5.6

57

5.8

5.9

5.10

Test page navigation

Test menu item 'Pages...'

Find of interaction

Find of lifeline
Find criteria persistence

Find short-cut

Filter of interactions

Filter of lifelines

Deselect filter

Filter criteria persistence

Zoom-in

Selection after zooming

Zoom-out

Use buttons and menu items 'Go to next page', 'Go to
previous page', 'Go to last page' and 'Go to first page' to

navigate through trace. Use also menu item 'Pages...' to jump

to specific page

1) Select menu item 'Pages..."
2) In text box type “9"
3) Click on 'OK’

Goto to page 1 -

1) Use button and menu item “Find”

2) select Interactions and deselect lifeline
3) type regular expression 10.*00

4) press find

5) press find

6) press find

7) press find

8) press find

Goto to page 1~

1) Use button and menu item “Find”

2) select lifeline and deselect interaction
3) type player2

4) press find

5) press find

1) Restart eclipse
2) open find dialog

1) Select 'Sequence Diagram' view
2) pres CTRL+F

Goto to page 1 -~

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Interactions and deselect Lifeline
3.2) type regular expression 10.*03

4) Press 'Create’

5) Press 'Ok’

Goto to page 9 »

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Lifelines and deselect Interactions
3.2) type regular player2

4) Press 'Create’

5) Press 'Ok’

) Apply one Filter

) Use menu item 'Hide Patterns...'
) deselect filter

) click 'Ok’

1) Restart eclipse
2) open hide dialog

1
2
3
4

1) Use button and menu item for zoom-in to activate zooming

in
2) click into sequence diagram view

1) Click on button and menu item 'Select' to go back to
selection mode
2) select an interaction

1) Use button and menu item for zoom-out to activate
zooming out
2) click into sequence diagram view

Verify that different time ranges are selected when
changing page by looking at Histogram View.
Histogram View window will show the start of the
page. Note that there are 10000 interactions per page.
In this traces there are in total 160032 interactions.
?('o:erli.Fy that last page has 32 interactions between 2
ifelines.

Verify that a dialog box will show. Verify that for this
trace it shows 'Total: 17 pages is shown” and the
current page is displayed in the text box. After step 3)
verify that page where changed to page 9. For this
trace page 9 is the page with 3 lifelines.

After 4) verify that interaction 10000 (player1 -
master) is selected. After 5) verify that interaction
10100 (master - player1) is selected. After 6) verify
that 10000 (player2 - master) is selected. After 7)
verify that interaction 10100 (master — player2). After
8 nothing else will be found

After 4) verify that lifeline with name player2 is
selected (page 9 with 3 lifelines). After 5) player2 is
selected on page 10

Verify that previous used find criteria are still in the list

Verify that find dialog opens

After 5) verify that Interactions with name 10003 and
10103 are not shown

After 5) verify that player2 is not shown

Verify that all lifelines and interactions are shown
Verify that previous used hide criteria are still in the list

Verify that 'Sequence Diagram' view zooms in. Note
that no selection is possible.

Verify that selection is possible.

Verify that 'Sequence Diagram' view zoom out. Note
that no selection is possible.



5.15

5.22

5.24

1) Use button and menu item for 'Reset zoom factor' to reset Verify that 'Sequence Diagram' view goes back to

Reset zoom the zoom level

1) Select menu item 'Configure Min Max'

2) Change min to 100 and max to 2000 (keep scale and
precision)

Configure min/max 3) press 'Ok’

After changing min and max
1) select menu 'Configure Min Max'
2) press 'Default’ 3) press 'Ok’

Goto to page 1~

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Use menu item Navigation - Show node end

Configure min/max
(default)

Show node end

Goto to page 1 -~
1) Resize view so that the beginning of the interactions are
not shown
2) select on interaction
Show node start 3) Use menu item Navigation — Show node start
Goto to page 1 -~
1) Resize view so that the arrow of the interaction is not
shown
2) select on interaction

Show node end short-cut 3) Press SHIFT+ALT+END

Goto to page 1~
1) Resize view so that the arrow of the interaction is not
shown
2) select on interaction
Show node start short-cut 3) Press SHIFT+ALT+HOME

Scroll down short cut Press SHIFT+ALT+ARROW_DOWN

Scroll up short cut Press SHIFT+ALT+ARROW_UP

Goto page 9 - Keep pressing + icon at the lowest right corner Verify that it's possible to navigate through a page of

Overview feature of the view and drag down, up, left or right

Select 'Sequence Diagram' view and press printer icon in the
Eclipse's tool bar (or use CTRL+P). Select one pager page to

Print print

1) Create 1filter if necessary (see 5.8)

2) Open Error Log view if necessary

3) Open ﬁlter dialog box and remove all filters
4) Press 'Ok’

5) Open filter dialog box again

Remove filter (Bug
391714)

default zoom

After 1) verify that a dialog box shows with default
values. After 3) verify that time compression bar
changes some colors. It will show more deeper red
because the max value is lower.

After step 2) the default values are shown. After step
3) the time compression bar will change colors. Note
that the default values are computed based on all
deltas of 2 consecutive interactions.

Verify that end lifeline of the interaction (the arrow) is
shown

Verify that start lifeline of the interaction is shown

Verify that end lifeline of the interaction (the arrow) is
shown

Verify that start lifeline of the interaction is shown

Verify that within a page the display scrolls down per
view size

Key combination on Ubuntu 12.04 is used for
something else. This can be disabled using the
combiz-settings-manager
(http://askubuntu.com/questions/171489/how-to-
unbind-shift-alt-up-shortkey-in-12-04)

After disabling this combination this test case
passes

Verify that within a page the display scrolls up per view

/ On Ubuntu 14.04, 14.10, this is not an issue, by
size

default the keys are not mapped.

On Ubuntu, the movement is hectic and the overview
box is very narrow.

On Mac OS X 10.8, the button is not visible but there is
a visible empty space that is clickable in its place.
Clicking on it brings up the overview box which has a
reasonable size but movement is still hectic.

the sequence diagram view Bug 436442

Getting printer data on my Ubuntu 14.04 hangs

Verify that it is possible to print (Printer.getDefaultPrinterData() in SDPrintDialogUl)

Verify that no exceptions occurred and after 5) no filter
are listed



1) Open trace without any sequence diagram information
2) Open SD view if necessary
3) Open Error Log view if necessary

Time Sync. without 4) change time range in Histogram view
5.27  interactions (Bug 391716) 5) Change time current selected time in Histogram View Make sure that no exceptions occurred



To Do

Section Comment
TMF - Statistics View

Target: Windows 7 64 bit

Step Test Case Action Verification Comment
1 Preparation
Download traces simple-server-thread1 and simple-
Preparation server-thread1 from traces/import/
1.1 Open Perspective Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views Pass
Use menu Window — Show View - Other ... - Tracing —»
1.2 Open TMF Statistics View Statistics Verify that 'Statistics' view is shown Pass | Path is actually Window -> Show view -> Tracing -> Statistics

1) Create Tracing Project

2) Create Experiment (SeqExp) Verify that statistics are shown per trace and per event
3) Import 2 traces simple-server-thread1 and simple-server-  type. Each trace has 80021 events. Verify that event
thread2 types
4) Select trace type "Generic CTF Trace" ENTER/RETURN/SEND/RECEIVE/INFO/after_fork_child
1.3 Open experiment 5) Add these 2 traces to experiment are counted. Pass
2 Manage View
2.1 Delete view Close the 'Statistics' View Statistics' view is removed from perspective Pass
Use menu Window — Show View — Other ... - Tracing -
2.2 Open view Statistics Statistics' view View is displayed and re-populated Pass  See comment on step 1.2 about the path
Randomly, the number of events in a trace stays at zero
when the statistics view is opened. However, | can't
Verify that statistics are shown per trace and per event reproduce the problem at will. Bug 436416
type. Each trace has 80021 events. Verify that event
Open view when types France : | have tried many times to open the view when
experiment/trace is 1) Close 'Statistics View' 2) load trace above trace 3) Open ENTER/RETURN/SEND/RECEIVE/INFO/after_Ffork_child the trace is already loaded and was not able to redo the
2.3 already loaded 'Statistics' view are counted Pass  problem
3 Other
Verify that 'Statistics' view is populated when indexing
3.1 Build of statistic index Open trace is finished Pass | The view is populated gradually during indexation
Verify that when opening the trace the x-times (x > 1),
Open same trace multiple times after indexing of trace was  that the statistics appear right away without parsing
3.2 Persistence of statistics  finished the first time the trace again Pass

4 Range Synchronization
External synchronization In any other view that supports range synchronization, select Events in selected time range'is updated and equals

4.1 (Full) the full range of the trace. 'Events total' values Pass  Bug 459571
External synchronization In any other view that supports range synchronization, select Events in selected time range' is updated according to
4.2 (range) anew range. new range Pass  Bug 459571

Multiple Trace
5 Synchronization

1) Download traces.zip (if necessary) and unzip into a local
directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-

testing
Preparation 4) Create experiment with trace of 2) in it
Open multiple traces (no . , L ) France : I am not sure what to do in this section (overlaping vs non
5.1 overlap) Open multiple traces that don't overlap in time View shows the last opened trace Pass  overlaping)

Change selected time and In any other view that supports range synchronization, select Events in selected time range' is updated according to
5.2 range (no overlap) anew range new range Pass



53

54

55

5.6
5.7

Select other trace (no
overlap)

Open multiple traces
(overlap)

Change selected time and In any other view that supports range synchronization, select

range (overlap)

Select other trace
(overlap)

Close all traces

Select different trace by clicking its Events editor tab
Open multiple traces that overlap in time

anew range

Select different trace by clicking its Events editor tab
Close all Events editor tabs

View is updated to show selected trace. 'Events in
selected time range' is updated according to the
selected trace's previously selected range.

View shows the last opened trace

Events in selected time range' is updated according to
new range

View is updated to show selected trace. 'Events in
selected time range' is updated according to the newly
selected time and range.

View is cleared.






Section Pass Fail ToDo Comment
TMF - Time Chart View 25 | o |3
Target: Windows 7 64 bit

Step Test Case Action Verification Comment

1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. Pass
1.2 Preparation step 2 Show Time Chart View Time Chart view is shown Pass

2 Trace handling
Trace #1 entry added to Time Chart view. Trace #1 is
2.1 Open trace Open an LTTng CTF Kernel trace #1 selected entry. Range of view is full trace range. Pass

Trace #2 entry added to Time Chart view. Trace #2 is
selected entry. Range of view is union of full trace
2.2 Open other trace Open an LTTng CTF Kernel trace #2 ranges. Pass

Experiment entry added to Time Chart view.
Experiment is selected entry. Range of view is union of

2.3 Open experiment Open an experiment full trace ranges. Pass
Trace #1is selected entry. View range does not change.
2.4 Select other trace Select trace #1 by clicking its trace entry in Time Chart view  Trace #1 editor tab is brought to top. Pass
Select other trace
2.5 (external) Select trace #2 by clicking its editor tab Trace #2 is selected entry. View range does not change.|  Pass
2.6  Close view Close the Time Chart view Time Chart view is removed from perspective Pass
Time Chart view is displayed and re-populated with
2.7 Open view Show Time Chart view opened traces data Pass
Trace entry is removed from Time Chart view. Range is
2.8 Close trace/experiment  Close trace #2 editor tab. Repeat with experiment editor tab. view is union of remaining full trace ranges. Pass
2.9  Close last trace Close trace #1 editor tab View is cleared. Pass
3 Time Synchronization
Other views are synchronized to the selected time.
Mouse synchronization Event at or following the selected time is selected in
3.1 (single time) Left-click on the time chart. The selected time line is updated. the event table. Pass
Other views are synchronized to the selected range.
Mouse synchronization  Shift-left-click or left-drag on the time chart. The selected Event at or following the selected time is selected in
3.2 (time range) time range is updated. the event table. Pass
External synchronization Selected time line is updated to the event time. If
3.3 (single time) In event table, select an event. necessary, range is updated to show selected time. Pass
External synchronization
3.4 (time range) In event table, select an event range with shift-left-click. Selected time line is updated to the time range. Pass
Zoom Range

4 Synchronization
Mouse wheel

4.1 synchronization Zoom infout with mouse wheel while holding Ctrl. Other views are synchronized to the new range Pass
Mouse drag zoom
4.2 synchronization Drag zoom with right-button on time chart. Other views are synchronized to the new range Pass
Mouse drag move
4.3 synchronization Drag move with ctrl-left or middle button on time chart. Other views are synchronized to the new range Pass
Mouse full range
4.4 synchronization Double-click with left button on time chart's time scale. Other views are synchronized to the full range Pass
In any other view that supports range synchronization, select
4.5 External synchronization anew zoom range. View range is updated to the new range Pass
Event Table
5 Synchronization
5.1 Search synchronization  Enter a search regex in event table Matching events are marked in time chart Pass  Bug 436324: Text is not seen as is it typed into the text field on GTK3
5.2 Search cleared Clear the search regex in event table Marks are removed in time chart Pass  France : I am not sure what to do in this section
53 Filter synchronization Enter a filter regex in event table Non-matching events are removed from time chart Pass
5.4 Filter cleared Clear the filter regex in event table All events are shown in time chart Pass
Bookmark
5.5  synchronization Add a bookmark in event table Bookmarked event is marked in time chart Pass

5.6 Bookmark cleared Remove the bookmark in event table Mark is removed in time chart - Bug 436323: Bookmark is not removed right away, only when the view is refreshed. This bug used to be GTK3 only but is reproducible with GTK 2.24.25 on Ubuntu 14.10



Section F13 Fail ToDo Comment

TMF - Custom Parsers 27 n 3

Target: Windows 7

Step Test Case Action Verification Comment

0 Prerequisites
0.1  Get custom parser definition and logs Find text and XML test files.

1 View management
Open and reset Tracing perspective, and

1.1 Open perspective open Time Chart view Time Chart view opens. Pass
Create a tracing project and import a text
1.2 Import traces and XML custom trace Traces imported in Traces folder of project. Pass

2 Custom parser management

Open Manage Custom Parsers dialog in
2.1 Open Manage Custom Parsers dialog Traces folder context menu Dialog opens. Pass

Select "Text" radio button, click New...
button, enter Log Type, change stuff,

2.2 New (text) click Next, click Finish Custom parser appears in list. Pass It is actually "Trace type" not "Log type"
Select custom parser, click Edit..., Previously entered data appears, can be

2.3 Edit (text) change stuff, click Next, click Finish edited. Pass
Select custom parser, click Export, enter

2.4  Export (text) name, click Save Exported custom parser stored in file system. Pass

2.5 Delete (text) Select custom parser, click Delete Custom parser is deleted. Pass
Click Import, find custom parser

2.6  Import (text) definition, click Open Imported custom parser appears in list. Pass

Select "XML" radio button, click New...
button, enter Log Type, write an xml log
in the input,
<a><b><c>1</c><d>1</d></b><b><c>2<
/c><d>1</d></b></a> then click on
feeling lucky. set c to timestamp logged

and d to message logged, set timestamp France : | go stuck in the "New..." window (I was not

able to click on Next or FInish button because | was

format to ss in both text boxes, click Next, o missing info). Action description should be more
2.7 New (XML) click Finish Custom parser appears in list. Pass precise.
Select custom parser, click Edit..., Previously entered data appears, can be
2.8  Edit (XML) change stuff, click Next, click Finish edited. Pass
Select custom parser, click Export, enter
2.9 Export (XML) name, click Save Exported custom parser stored in file system. Pass
2.10 Delete (XML) Select custom parser, click Delete Custom parser is deleted. Pass
Click Import, find custom parser
2.11  Import (XML) definition, click Open Imported custom parser appears in list. Pass

3 Custom parser trace handling

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom Text Trace type is assigned (re-open Select Trace
3.1 Select trace type (text) > (parser name)" Type sub-menu to verify) Pass



3.2
3.3

34

3.5

3.6
37

3.8

41

4.2

43

44

45

4.6

Open trace (text)
Raw view (text)

Time synchronization (text)

Select trace type (XML)

Open trace (XML)
Raw view (XML)

Time synchronization (XML)

Raw viewer

Show Raw Viewer
Hide Table

Show Table

Select Event (Bug 457852)

Select Event using arrow keys

(457852)

Hide Raw viewer

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom XML Trace type is assigned (re-open Select Trace

> (parser name)"

Double-click on test file in Traces folder
Right-click in editor, click Show Raw

Click in Time Chart view, select event in
editor table, select event in raw view

1) Open Custom text trace
2) Right-click in table and select "Show
Raw"

Right-click in table and select "Hide
Table"

Right-click in table and select "Show
Table"

Select event in raw viewer

1) select event in raw viewer with mouse
2) use arrow key down and up several
times

Right-click in table and select "Hide Raw" is shown

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

Raw viewer is shown beside the events table

Events table is hidden and only raw viewer is
shown

Events table is shown beside raw viewer

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Correct event is select in table, timestamp is
propagated to other TMF views and
Properties view shows content of selected
event

Raw viewer is hidden and only events table

France : | could no test, was not able to load trace
correctly because of the custom settings probably. |
suggest to clarify the action description of action 2.2

Matthew: works but we should specify "valid trace"



Target:

Section
TMF - State System Explorer
Windows 7 64 bit

Test Case

Verification

To Do Comment

Comment

2.1

22

2.3

2.4

2.5

2.7
2.6

2.7

3.1

32

4.1

42

Preparation
Open TMF State System Explorer
View

Manage View

Delete view

Open view

Open Trace

Open view when trace is already
loaded

Open Experiment

Select other trace
Restart

Close all traces

Timestamp / Time Range
Selection

Select timestamp

Select time range

Displaying of Changed Values

Highlighting of changed values
“Only Display Changes at Selected
Timestamp” option with event
selection

“Only Display Changes...” with
timestamp selection

Use menu Window — Show View — Other ...
State System Explorer

— Tracing —

Close the State System Explorer' View

Use menu Window — Show View — Other ...
State System Explorer

— Tracing —

Open an LTTng Kernel Trace

1) Close State System Explorer View
2) Load LTTng trace
3) Open 'State System Explorer' view

Open Experiment with 2 or more LTTng traces

Select different trace by clicking its Events editor tab
Restart Eclipse

Close traces and experiment one by one from the editor tab

Select time in another view (e.g Histogram view) that supports
time synchronization

Select a time range in another view that supports time
synchronization

Select many different timestamps one after the other

Enable the “Only Display Changes...” option with the toolbar
button. Select different Events from the Event Table.

Enable the “Only Display Changes...” option. Select
*timestamps* corresponding to state changes (for example,
using the previous/next buttons in the Control Flow View).

Verify that 'State System Explorer' view is shown

'State System Explorer' view is removed from perspective

'State System Explorer' view is displayed and re-populated

Verify that view is populated with kernel state system
(o.c.t.analysis.os.linux.kernel) and statistics state systems (o.e.l.tmf.statistics.*)
of opened trace

Verify that view is populated with state systems from trace

Verify that view is populated with all kernel state system and statistics state
systems of opened experiment (separated by trace)

View is updated to show selected trace. State values, start time and end time are

updated according to the selected trace's previously selected range.

Verify that view is populated with state systems from trace

Verify that state system explorer view is cleared after closing the last trace

Verify that state values are updated

Verify that only the start of the range is taken in consideration (changing the
end time of the range should not affect the displayed values)

Attributes whose value changed in the last timestamp selection should be
highlighted in yellow.

Verify that only the state values that changed because of that event are
displayed.

Verify that only the state values that changed at that timestamp are displayed.

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Some state systems ID's should be renamed for Trace Compass

(if the state system were already built)

The values are only available for time ranges where the trace
exists. Only after we've "visited" other timestamps, then the
attributes show up and print "Out of range".
http://eclip.se/443653

France : T am not sure what to do here



Target:

Section
TMF - Call Stack View
Windows 7 64 bit

Test Case

Verification

To Do Comment

Comment

0 Download the test resources Download this
1 Preparation
Use menu Window — Show View — Other ... — Tracing —
1.1 Open TMF Call Stack View Call Stack Verify that 'Call Stack' view is shown Pass  Path is actually Window -> Show view -> Tracing -> Call stack
Import a trace that does not have any call stack information, like Verify that nothing is shown in the view, except “Stack info not available
1.2 Import generic trace a standard kernel trace (<tracename>)” Pass
1.3 Import cyg-profile trace Import the trace in the "trace" directory of the downloaded zip ~ Verify that the Callstack View is populated with some callstack information. Pass
1.4 Import cyg-profile-fast trace Import a trace in the "trace-fast" directory of the downloaded zip Verify that the Callstack View is populated with some callstack information. Pass
2 Manage View
2.1 Delete view Close the Call stack view' View 'Call Stack' view is removed from perspective Pass
Use menu Window — Show View — Other ... — Tracing —
2.2 Open view Call Stack 'Call Stack' view is displayed and re-populated Pass  Sce comment 1.1. about the path
2.3 Open Trace Open "trace(-fast)" trace Verify that view is populated with call stack information Pass
1) Close 'Call Stack' view
2) Open "glxgears-cyg-profile(-fast)" trace located in the git in
ctf test
2.4 Open view when trace is already loaded 3) Open 'Call Stack' view Verify that view is populated with call stack information Pass
Open Experiment with 2 or more Call Stack traces. Verify that view is populated with all call stack information (separated by
2.5  Open Experiment (You can use both traces) trace). Pass
2.7 Select other trace Select different trace by clicking its Events editor tab View is updated to show selected trace. Pass
2.6  Restart Restart Eclipse with Call Stack trace opened Verity that view is populated with call stack from trace Pass
2.7 Close all traces Close traces and experiment one by one from the editor tab Verify that Call Stack view is cleared after closing the last trace Pass
3 Navigation
Selected time line is updated. Table is updated to show the full stack
3.1  Select time Click on random time in the time graph pane information at the selected time. Selected time is updated in other views. Pass
Previous or next call stack change is selected and corresponding active function
and stack depth is selected. Table is updated to show the full stack information
3.2 Select Previous/Next Event Click Previous/Next Event button at the selected time. Selected time is updated in other views. Pass
3.3 Zoom to function (table) Double-click on a function in the table pane Time range is updated to the full duration of the selected function Pass
3.4 Zoom to function (time graph) Double-click on a function (interval) in the time graph pane Time range is updated to the full duration of the selected function Pass
4 Synchronization
Selected time line is updated. Table is updated to show the full stack
information at the selected time. If selected time is outside current range, time
4.1  Time synchronization Select a random time in another view range is updated to include it. Pass  The vertical scroll bar is not updated
Select a call stack-impacting event (function entry/exit) in events In addition to updating the selected time, the active function at the event time is
4.2 Event synchronization table selected. Vertical scroll bar is updated if necessary. Pass
4.3  Time range synchronization Select a new time range in Histogram view. Time range is updated. Pass  The vertical scroll bar is not updated
5 Function name import - Text file
Click the "Import a textfile..." button in the view. Select a
5.1 Invalid text file import random file that does not contain any debugging info. The function addresses do not change. Pass  France : 1 am not sure what to do here
The symbol mapping is applied on view level. If multiple traces
. . N . . N . . d, or if iment with multiple traces is d,
The view now displays function names instead of function addresses (both in ?ﬁ:;g:ﬁﬁm ggc‘h?x:qﬁ;‘? §?vn‘ﬁap?fﬁg‘.p31£ 3?959‘89@6“6
5.2 Valid text file import Import a file "fibonacci.symbols" the timegraph and the call stack areas). Pass  France : I am not sure what to do here


https://drive.google.com/file/d/0BxUCnNTRLr5pWUdXd0JJV3hyeEk/edit?usp=sharing

Click the "Import Binary..." button in the view, select the
Binary import fibonacci executable (fibonacci) The view now displays the function names for both traces France : I am not sure what to do here




Target:

Step

1.1

2.1
2.2

3.4
3.5
3.6
3.7
3.8

5.1
5.2

5.5
5.6

5.7
5.8
59

6.1
6.2

Section Pass
TMF - Remote Fetching 53

Test Case Action

Preparation
Step 1 Open Trace Compass and reset Lttng perspective
Opening
Right-click on Traces Folder -> Fetch Remote Traces ... ->

Open Profile Editor 1 Manage Profiles

Open Profile Editor 2 window -> Preferences-> Tracing -> Remote Profiles

Edit Profile - Add/Delete

Open Profile Editor > Click on 'Add' > Enter profile name,
remote information, root path and trace pattern

Select Profile node > right mouse click > select 'New
Connection Node'

Select node node > righ mouse click > select 'New Trace
Group'

Create Profile
Add Node
Add trace group

Add trace
Delete Trace

Select trace group > right mouse click > select 'New Trace'
Select trace > right mouse click > select Delete

Delete Trace Group
Delete Connection Node
Remove Profile

Select Trace Group> right mouse click > select Delete
Select Connection Node > right mouse click > select Delete
Select Profile > click on 'Remove' button

Edit Profile - Reorder

Create at 2-3 profiles > select 2nd profile and press buttons
'Move Up'/'Move Down'

Make sure that there are 2 or 3 connection nodes > select 1
connection node > click buttons 'Move Up'/'Move Down'

Move profile up/down

Move connection node
up/down

Fail

Verification

Lttng perspective opens with correct views

The Profile Editor of preference page opens
The Profile Editor of preference page opens

New Profile is created and template is provided

New Connection Node is create under the profile and
template is provided

New Trace Group is created under the node and template
is provided

New Trace is created under Trace Group and template is
provided

Trace is deleted

Trace Group is deleted
Connection Node is deleted
Profile is deleted

Profiles are moved up and down

Connection Nodes are moved up and down within a profile

Make sure that there are 2 or 3 trace gropus > select 1 trace Trace Groups are moved up and down within a connection

Move Trace Group up/down  gropu > click buttons 'Move Up'/'Move Down'

Make sure that there are 2 or 3 trace gropus > select 1 traces

Move Trace up/down > click buttons 'Move Up'/'Move Down'

Edit Profile - Copy, Cut, Paste

Select Profile > click right mouse button on a profile > Select

Copy -> click right mouse button on other profile > Select
Paste

Redo 5.1 with CTRL+C and CTRL+V keys

Select Profile > click right mouse button on a Connection
Node > Select Copy -> click right mouse button on other
Connection Node > Select Paste

Copy/Paste Profile
Copy/Paste Profile (Keys)

Copy/Paste Connection Node
Copy/Paste Connection Node

(Keys) Redo 5.3 with CTRL+C and CTRL+V keys
Select Profile > click right mouse button on a Trace Group >
Select Copy -> click right mouse button on other Trace Group
Copy/Paste Trace Group > Select Paste

Copy/Paste Trace Group (Keys) Redo 5.5 with CTRL+C and CTRL+V keys

Select Profile > click right mouse button on a Trace > Select
Copy -> click right mouse button on other Trace > Select

Copy/Paste Trace Paste
Copy/Paste Trace (Key) Redo 5.5 with CTRL+C and CTRL+V keys
Cut/Paste Redo 5.1 - 5.8 with cut and paste

Edit Profile - Adverserial
Error empty profile name
Duplicate profile name

Clear profile name
Add profile with name of existing profile

node

Traces are moved up and down within a Trace Group

Profile is pasted under the selected profile
Profile is pasted under the selected profile

Profile is pasted under the selected Connction Node

Profile is pasted under the selected Connction Node

Profile is pasted under the selected Trace Group
Profile is pasted under the selected Trace Group

Profile is pasted under the selected Trace
Profile is pasted under the selected Trace

Successful cut and paste

Error message "Profile must not be empty"
Error message "Duplicate profile name"

Type

SWTBot
SWTBot

SWTBot
SWTBot
SWTBot

SWTBot
SWTBot
Manual
Manual
SWTBot

Manual
Manual
Manual

SWTBot

Manual
Manual

Manual

Manual

Manual
Manual

SWTBot
Manual
Manual

Manual
Manual

To Do

Comment

[ o |

Pass

Pass
Pass

Pass

Pass

Pass

Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass
Pass

Pass
Pass
Pass

Pass
Pass

Comment

Trace (5.7) is done with SWTBot



6.3

6.4
6.5

6.6
6.7
6.8
6.9

71
7.2

73

8.1

8.2

8.3

8.4

8.5

8.6

8.7

8.8

Error empty Connection node

name

Duplicate Connection node
name

Missing username in URI

Invalid URI

Error empty Trace Group
Error empty Trace
Invalid File pattern

Export/Import Profile

Export Profile
Import Profile

Import Profile

Remote Fetch Wizard

Preparation

Create and run Profile "new

Clear Connection node name
Within a profile, add Connection node with name of existing
node

remove user name of a Connection Node

add invalid URI

Delete Trace Group name

Delete File Pattern

Add trace with invalid regular expression

Select multipe profiles > Click Export Button > Select Folder
and enter file name > OK

Click on Import Button > select profile XML file > OK

Redo 7.2

1) Import Test Profiles (test-profiles.xml) from test spec.
template directory

2) Extract test traces.zip from test spec. template directory
3) Load custom text parsers located in traces.zip

1) Create traces in /tmp/traces/syslog and
/tmp/traces/generated/synthetic-trace

2) Create Profile with Local connection, 1 trace group (root
/tmp/traces/) and 2 traces (.*syslog.* and .*synthetic.*) in
this group

3) Select profile in Remote Fetch Wizard (Remote Page)

Profile" (syslog + synthetic CTF 4) Click on 'Next' button

trace in sub-directory)
Clear traces

Create and run Profile "new

5) Click on 'Ok’
Delete all traces from Traces directory

1) Create traces in /tmp/traces/syslog and
/tmp/traces/generated/synthetic-trace

2) Create Profile with Local connection, 1 trace ﬁroup (root
/tmp/traces/) and 2 traces (.*syslog.* and .*synthetic.*) in
this group

3) Select profile in Remote Fetch Wizard (Remote Page)

Profile" (syslog + synthetic CTF 4) Click on 'Next' button

trace in sub-directory), only 1
trace selectted

Clear traces

Re-run Profile
"TestAllRecursive" (1)

Re-run Profile
"TestAllRecursive" (Rename)

Re-run Profile
"TestAllRecursive"
(Overwrite)

Re-run Profile
"TestAllRecursive" (Skip)

Re-run Profile

"TestAllRecursive" (Overwrite
2

5) deslect the synthetic CTF trace
5) Click on 'Ok’

Delete all traces from Traces directory

1) Edit Profile to point root directory of extracted test traces
of traces.zip

2) Select profile in Remote Fetch Wizard (Remote Page)

3) Ckick on 'Next' button (enter password if needed)

4) Click on 'Ok’

5) In dialog box select 'Rename’ for the first trace and
'Rename ALL' for the second traces

1) Select profile in Remote Fetch Wizard (Remote Page)
2) Click on 'Next' button (enter password if needed)

3) Click on 'Ok’

4) In dialog box select 'Rename' for the first trace and
'Rename ALL' for the second traces

1) Select profile in Remote Fetch Wizard (Remote Page)
2) Click on 'Next' button (enter password if needed)

3) Click on 'Ok’

4) In dialog box select 'Overwrite' for the first trace and
'Overwrite ALL' for the second traces

1) Select profile in Remote Fetch Wizard (Remote Page)

2) Click on 'Next' button (enter password if needed)

3) Click on 'Ok’

4) In dialog box select 'Skip' for the first trace and "Skip ALL'
for the second traces

1) Select profile in Remote Fetch Wizard (Remote Page)
2) Select checkbox 'Overwrite traces without warning'
3) Click on 'Next' button (enter password if needed)

4) Click on 'Ok’

Error message "Node name must not be empty"

Error message "Duplicate node names"

Error message "URI must include user information"

Error message "URI must include valid host and port
number"

Error message "Trace Group name must not be empty"
Error message "File name must not be empty"

Error message "Invalide File Pattern"

Only selected profiles are exported

Profiles are emported

after second import an error message appears "Duplicate
profile names"

Verify that all test traces are imported with correct trace
types assigned. Verify that folder structure is preserved.

All traces deleted

Verify that only the selected traces are imported with
correct trace types assigned. Verify that folder structure is
preserved.

All traces deleted

Verify that all test traces are imported with correct trace
types assigned (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

Verify that all test traces are imported with new name and
correct trace types assigned (LTTng kernel, LTTng UST,
custom text, custom XML). The file unrecognized.log is
importeds with unrecognized trace type. Make sure that
directory structure is preserved.

Verify that all test traces are imported with correct trace
types is assigned where old traces are overwritten. (LTTng
kernel, LTTng UST, custom text, custom XML). The file
unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

Verify that all test traces are skipped and no trace is
imported

Verify that all test traces are imported with correct trace
types assigned where old traces are overwritten (no
dialog box opens). (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

Manual

Manual
Manual

Manual
Manual

Manual

SWTBot
SWTBot

Manual

SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Local connection is used in SWTBot

Local connection is used in SWTBot



8.9

8.11

8.12

8.13

8.14

9.1

9.2

10

Clear traces

Re-run Profile
"TestAllRecursive" (2)

Clear traces

Run Profile
"TestAllNonRecursive"

Clear traces

Run Profile
"TestSpecificRecursive"

Clear traces

Run Profile
"TestSpecificNonRecursive"

Clear traces
Run Profile

"TestSpecificMutliGroupRecur
sive"

Cancel Import
Clear traces

Run Profile "TestMultiNodes"

Connection Handling

Error cannot connect to
remote host (node doesn't
exist)

Error cannot connect to

Delete all traces from Traces directory

1) Select profile in Remote Fetch Wizard (Remote Page)
2) Click on 'Ok’

Delete all traces from Traces directory

1) Select profile in Remote Fetch Wizard (Remote Page)
2) Ckick on 'Next' button (enter password if needed)
3) Click on 'Ok’

Delete all traces from Traces directory
1) Select profile in Remote Fetch Wizard (Remote Page)

2) Ckick on 'Next' button (enter password if needed)
3) Click on 'Ok’

Delete all traces from Traces directory
1) Select profile in Remote Fetch Wizard (Remote Page)

2) Ckick on 'Next' button (enter password if needed)
3) Click on 'Ok’

Delete all traces from Traces directory
1) Select profile in Remote Fetch Wizard (Remote Page)

2) Ckick on 'Next' button (enter password if needed)
3) Click on 'Ok’

1) Create profile with directory with many CTF traces
2) Click on 'Ok’
3) Cancel import (red square or Cancel button)

Delete all traces from Traces directory

1) Select profile in Remote Fetch Wizard (Remote Page)
2) Ckick on 'Next' button (enter password if needed)
3) Click on 'Ok’

Create profile with IP address that cannot be connected to
and run profile

Create profile valid IP address. When asked for password

remote host (wrong password) enter invalid password

Other Remote Backends

Remote Fetch using RSE
Clear traces

Remote Fetch using Local

Create profile (see 7.3) with URI scheme rse (instead of ssh)
and redo test 7.3

Delete all traces from Traces directory

Create profile (see 7.3) with URI scheme file (instead of ssh)
and node name Local and redo test 7.3

All traces deleted

Verify that all test traces are imported with correct trace
types assigned. The second page is omitted. (LTTng
kernel, LTTng UST, custom text, custom XML). The Ffile
unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

All traces deleted

Verify that only traces from root path are imported

(LTTng kernel, LTTng UST, custom text, custom XML). The
file unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

All traces deleted

Verify that only kernel and custom text logs are imported
from root and subdirectory. Make sure that directory
structure is preserved.

All traces deleted

Verify that only kernel and custom text logs are imported
from root directory only. Make sure that directory
structure is preserved.

All traces deleted

Verify that only traces from root path are imported

(LTTng kernel, LTTng UST, custom text, custom XML). The
file unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved.

Verify that import operation is cancelled

All traces deleted

Verify that only traces from root path are imported

(LTTng kernel, LTTng UST, custom text, custom XML). The
file unrecognized.log is importeds with unrecognized trace
type. Make sure that directory structure is preserved. 2
nodes directories are created with the above traces stored

Operation to connect to remote node fails and error dialog
is shown with detailed information (after time-out)

Operation to connect to remote node fails with time-out
and error dialog is shown with detailed information. Note
time-out is as per remote development preferences

Verify that all test traces are imported with correct trace
types assigned (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

All traces deleted

Verify that all test traces are imported with correct trace
types assigned (LTTng kernel, LTTng UST, custom text,
custom XML). The file unrecognized.log is importeds with
unrecognized trace type. Make sure that directory
structure is preserved.

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

SWTBot

N/A

RSE not available with 0.e.remote 2.0.0

See tests 7.2/7.3



Section
LTTng 2.0 - Control Flow View

Target: Windows

Step

0

1.2
1.3

Test Case

Prerequisites
Import traces

Create experiment

View management
Open perspective

Open trace

Open experiment
Close view

Open view
View selection
Select process in table

Select process in time graph

Select state in time graph
Mouse handling

Drag move time range

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

Pass

Action

Import LTTng Kernel traces in Tracing
project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective

Fail

Verification

Control Flow view opens.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.

Open LTTng Kernel trace in Project Explorer Arrows are drawn between states of a CPU.

Open experiment with LTTng Kernel traces
in Project Explorer

Close the Control Flow view

Open the Control Flow view

Select a process in the table

Select a process in the time graph (empty
region)

Select a state in the time graph

Ctrl-Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down,

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

View is closed.

Control Flow view is opened and populated
with processes.

Same process is highlighted in time graph.

Same process is highlighted in table.
Selected time line is updated. Other views
are synchronized to selected time.

Same process is highlighted in table. State is
highlighted in time graph. Selected time line
is updated. Other views are synchronized to
selected time.

Time range is dragged. When mouse button
is released, states are updated and new time
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped

cursor inside time graph while holding the Ctl for a short time, states are updated and new

button

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down,
cursor outside time graph

time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Table and time graph scroll up and down and
remain aligned. Selected process does not
change. Vertical scroll bar updated.

To Do

Comment

| o |2

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Dragging also works with Ctrl-Left



3.5

3.6

3.7

3.8

3.9

3.10

3.1

4.1

4.2

4.3

44

5.1

5.2

5.3

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection
Keyboard handling

Keyboard navigation in table
(process selection)

Keyboard navigation in table (tree
expansion)

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph
(state selection)
Tool bar handling

Show Legend

Reset Time Scale

Select Previous/Next Event

Table and time graph scroll up and down and
remain aligned. Selected process does not
Click and drag vertical scroll bar change.

Selection highlighted. When mouse button is

released, time range is zoomed to selection,

states are updated and new time range is
Drag select time graph with right button propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to

Double-click left button on time scale other views.
Hover mouse in time graph over empty
region Tool tip shows process name only.

Tool tip shows process name, state name,

date, start time, end time, duration. For

USERMODE state, CPU is shown. For

SYSCALL state, CPU and System Call is

shown. For INTERRUPTED state, CPU is
Hover mouse in time graph over state shown.

Selection highlighted. Status bar of Eclipse is

updated with time information: T, T1, T2 and

delta, where T is the time of the mouse

position, T1 the left most selected time, T2

the right most selected time and delta the
Drag select time graph with left button time difference between T2-T1

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse

Click select with left button (begin time), position, T1 the left most selected time, T2
press shift key and click select another time the right most selected time and delta the
(end time) time difference between T2-T1

Selected process is changed. Time graph
With focus on table, use UP, DOWN, HOME, selection is updated. Vertical scroll bar

END keys updated.

With focus on table, For parent process, tree is expanded or

in Windows use LEFT, RIGHT keys while collapsed. Time graph item expansion is
parent or child process is selected updated. Vertical scroll bar updated. For child

process, left changes selection to parent,
in Linux use SHIFT LEFT, RIGHT keys while time graph selection is updated. Vertical

parent or child process is selected scroll bar updated. Tested in Windows

With focus on time graph, use UP, DOWN, Selected process is changed. Table selection
HOME, END keys is updated. Vertical scroll bar updated.

With focus on time graph, use LEFT, RIGHT Previous or next state is selected. Selected
keys time is updated in other views.

The legend dialog is opened and can be
Click Show Legend button closed.

Time range is reset to full range, states are
updated and new time range is propagated to
Click Reset Time Scale button other views.

Previous or next state is selected. Selected
Click Previous/Next Event button time is updated in other views.




Selected process is changed in table and
5.4 Select Previous/Next Process Click Previous/Next Process button time graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of time range. States are updated and

5.5 Zoom In/Out Click Zoom In/QOut button new time range is propagated to other views.
5.6 Filter Dialog Open Filter Dialog Verify that all buttons are working correctly
1) Open Filter Dialog
2) Deselect several processes Verify that only selected processes are
5.7 Filter Processes 3) Press Ok displayed in the view

Verify that arrows are not drawn in the time
5.8 Hide Arrows Click Hide Arrows button graph

Time graph is updated to show the next state
With focus on time graph, click Follow CPU for this cpu following the arrow, the event is
5.9 Follow CPU Forward Forward button selected in the Events editor.

Time graph is updated to show the previous
With focus on time graph, click Follow CPU  state for this cpu following the arrow, the
5.10 Follow CPU Backward Backward button event is selected in the Events editor.

6 Synchronization

Selected time line is updated. If selected time
is outside current range, time range is

6.1 Time synchronization Select a random time in another view updated to include it.
Select a state-impacting event In addition to updating the selected time, the
(sched_switch, syscall, ...) in events table or process containing the state change is
in Resources view using Select selected. Vertical scroll bar is updated if
6.2 Event synchronization Previous/Next event. necessary.
Select a new time range in Resources view
6.3 Time range synchronization or in Histogram view. Time range is updated.

Selection is highlighted. If begin time (T1) of
selected time range is outside the current
Time range selection In any other view that supports range range, then time range is updated to include
6.4 synchronisation synchronization, select a new range. it

7 Multiple Trace Synchronization

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace
${local}/traces/import/kernel-overlap-
testing

3) Import UST
${local}/traces/import/trace ust-overlap-

testing
Preparation 4) Create experiment with trace of 2) in it
Open multiple traces that don't overlap in
7.1 Open multiple traces (no overlap) time View shows the last opened trace
Change selected time and range Selected time line and time range is updated
7.2 (no overlap) Select a time and new range to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are
Select different trace by clicking its Events restored to the selected trace's previously

7.3 Select other trace (no overlap) editor tab selected time and range.
7.4 Open multiple traces (overlap)  Open multiple traces that overlap intime  View shows the last opened trace
Change selected time and range Selected time line and time range is updated

7.5 (overlap) Select a time and new range to selected time and new range.



View is updated to show selected trace.
Select different trace by clicking its Events Selected time line and time range are set to
7.6 Select other trace (overlap) editor tab the newly selected time and range.

7.7 Close all traces Close all Events editor tabs View is cleared.

1) Open LTTng Kernel Trace
2) Select Control Flow View
8.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Control Flow View is populated




Section
LTTng 2.0 - Resources View

Target: Windows 7

Step

0

1.2
1.3

Test Case

Prerequisites
Import traces

Create experiment

View management

Open perspective

Open trace

Open experiment
Close view

Open view
View selection

Select resource in time graph

Select state in time graph
Mouse handling

Drag move time range

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

Vertical scroll bar

Pass

Action

Import LTTng Kernel traces in Tracing
project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective,
and select Resources view

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces
in Project Explorer
Close the Resources view

Open the Resources view

Select a resource in the time graph (empty
region)

Select a state in the time graph

Ctrl-Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down on
header or ctrl mousewheel in the time graph

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down,
cursor outside time graph (in name space)

Click and drag vertical scroll bar

Fail

Verification

Resource view opens.

Resources Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

View is closed.

Resources view is opened and populated
with processes.

Resource is highlighted. Selected time line is
updated. Other views are synchronized to
selected time.

State is highlighted in time graph. Selected
time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button
is released, states are updated and new time
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Time graph scrolls up and down. Selected
process does not change. Vertical scroll bar
updated.

Time graph scroll up and down and remain
aligned. Selected process does not change.

To Do

Comment

| o |2

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Zoom in and out with Ctlr + Mouse wheel. Consider adding
that detail to the action description to clariry



3.6

3.7

3.8

3.9

3.10

3.1

4.1

4.2

5.1

5.2

5.3

5.4

5.5

6.1

6.2

6.3

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse seleection

Shit key selection
Keyboard handling

Keyboard navigation in time graph

(process selection)

Keyboard navigation in time graph

(state selection)
Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out
Synchronization

Time synchronization

Time range synchronization

Time range selection
synchronisation

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT
keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button

Select a random time in another view

Select a new time range in Control Flow
view or in Histogram view.

In any other view that supports range
synchronization, select a new range.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows resource name only.

Tool tip shows resource name, state name,
date, start time, end time, duration. For IRQ
state, IRQ number is shown. For
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state,
CPU is shown.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the left most selected time, T2
the right most selected time and delta the
time difference between T2-T1

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the left most selected time, T2
the right most selected time and delta the
time difference between T2-T1

Selected process is changed. Vertical scroll
bar updated.

Previous or next state is selected. Selected
time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in time graph.
Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of time range. States are updated and
new time range is propagated to other views.

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of
selected time range is outside the current
range, then time range is updated to include
it

On usermode and syscall tool tip shows also shows hover
time, tid and process name.

When not zoomed enough, tool tip does not show CPU for
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state.



7.1

7.2

7.3
7.4

7.5

7.6
7.7

8.1

Multiple Trace Synchronization

Preparation

Open multiple traces (no overlap)

Change selected time and range
(no overlap)

Select other trace (no overlap)
Open multiple traces (overlap)

Change selected time and range
(overlap)

Select other trace (overlap)
Close all traces

Miscellaneous

Restart (Bug 409345)

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace
${local}/traces/import/kernel-overlap-
testing

3) Import UST
${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in
time

Select a time and new range

Select different trace by clicking its Events
editor tab

Open multiple traces that overlap in time

Select a time and new range

Select different trace by clicking its Events
editor tab

Close all Events editor tabs

1) Open LTTng Kernel Trace
2) Select Resource View
3) Restart Eclipse

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are
restored to the selected trace's previously
selected time and range.

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are set to
the newly selected time and range.

View is cleared.

Verify that Resources View is populated




Section
LTTng 2.0 - Control View

Target: Ubuntu 14.04 64 bit

Step

0

LTTng Tools 2.6.0, Built-in SSH
Test Case

Prerequisites

Set Proxy
General
Open perspective

Manage View
Close view

Open Control view

Connection Handling

Create Host Connection

Disconnect

Connect

Select Host Connection

Node contexts sensitive menu (host
connected)

View button enable state (host
connected)

Node contexts sensitive menu (host
disconnected)

View button enable state (host
connected)

Delete

Create Host Connection with ssh port

Pass

Action

For the tests below a Ubuntu machine with LTTng 2.0 installed
(with Ittng tools 2.0.x) is required. Either create a machine
yourself or use machine vCloud machine 142.133.166.54.

Fail

Verification

Make sure that the root session daemon is running (sudo Ittng LTTng Tracer Control User Guide:

list -k) and have one UST process running (e.g. from Ittng-tools hftp:7/wiki.eclipse.org/Linux_Tools_Project/LTTng2/User

git repository under tests/hello.cxx)

a) Window — Preferences — General — Network Connections

b) Set “Active Provider” to “Direct”

Open and reset LTTng Kernel Perspective

Close Control View

Use menu Window — Show View — Other ... — Lttng —

Control

1) Click Button ‘New Connection..."

2) Select Tree item "Built-in SSH" and click on Create
3) Enter Connection Name (e.g. MyHost), enter Host Name (a
DNS name or IP address), username and password

4) Click 'Finish'

5) In Tree select the newly create connection and click on 'Ok’

a) Select host to disconnect and click Button 'Disconnect’
b) Redo test with context sensitive menu item 'Disconnect’

a) Select host to connect and click Button ‘Connect’
b) Redo test with context sensitive menu item ‘Connect'

1) Restart Eclipse
2) Click Button 'New Connection..."
3) Select the host previously created

4) Select 'OK'. (Afterwards enter user ID and Password if

necessary)

1) Connect to remote host

2) select connected node and click right mouse button

1) Connect to remote host (if necessary)

2) select connected node

1) Disconnect from node

2) select disconnnected node and click right mouse button

1) Disconnect to remote host (if necessary)
2) select disconnected node if necessary

a) Select node to delete (state disconnected) and click on

button 'Delete’

b) Redo test with context sensitive menu item 'Delete’

re-do 3.1 but this time specify a port number other than default The connection should fail (unless remote is configured

SSH port 22

_Guide#L T Thg_Tracer_Confrol

LTTng Kernel perspective opens with correct Control

view on the left bottom corner

Control view is removed from perspective

Verify that Control view is shown

Make sure that after 4) the new connection is shown in
the tree. Verify that the new host is shown in the Control
view (with 'Connection Name'. After Ssh connection has
been established, make sure that Provider and Session
nodes are created in the Control view underneath the
host. Verify that all active Providers (Kernel and UST
providers) are shown under the 'Provider’ node.

Verify that icon for the corresponding node changes to
the disconnect icon and all sub-nodes are removed.

Verify that icon for the corresponding node changes to
the connected icon and after successful SSH connection
all data is retrieved form the remote host (Providers,

sessions efc).

Make sure that SSH connection is established and all
data s retrieved from the remote host ( (Providers,

sessions efc).

Verify that menu items are shown and enabled/disabled

depending on state:
'Connect' (disabled)
Disconnect (enabled)
Refresh (enabled)
Delete (disabled)

Verify enable state of view buttons:
'New Connection...' (enabled)
'Connect' (disabled)
'Disconnect' (enabled)
'Refresh’ (enabled)

'Delete’ (disabled)

'Start' (disabled)

'Stop' (disabled)

'Destroy Session..." (disabled)
'Record Snapshot' (disabled)
‘Import..." (disabled)

Verify that menu items are shown and enabled/disabled

depending on state:
'Connect' (enabled)
'Disconnect’ (disabled)
'Refresh’ (disabled)
'Delete’ (enabled)

Verify enable state of view buttons:
'New Connection..." (enabled)
'Connect' (enabled)
'Disconnect’ (disabled)
'Refresh’ (disabled)

'Delete’ (enabled)

'Start' (disabled)

'Stop' (disabled)

'Destroy Session..." (disabled)
'Record Snapshot' (disabled)
‘Import..." (disabled)

Verify that host is removed from the control view. Verify
that host doesn't show up in available hosts when

creating a new connection (see 3.4)

for the specified port)

To Do

Comment
19

Comment


LTTng_Tracer_Control
LTTng_Tracer_Control
LTTng_Tracer_Control

4.1

4.2

43

4.4

4.5

4.6

4.7

4.8

4.9

4.10

4.1

4.12

5.1

52

Session Handling
Preparation

Sessions Context Sensitive Menu

Create Session (default location)

Create Session (custom location)

Create Session — session already exists

in GU

Create Session — session already exists

on node

Session Context Sensitive menu
(session inactive)

View button enable state (session
inactive)

Start Session

Session Context Sensitive menu
(session active)

View button enable state (session
active)

Destroy Session

Kernel Channel Handling

Preparation

Enable Channel on session level
(default values)

1) Connect to remote host

Select 'Sessions' in tree and click right mouse button

1) Click right mouse button on 'Sessions'
2) Select "Create Session..." in the context sensitive menu

3; Enter session name 'MySession’, keep 'Session Path’ empty 'Session Path’ ( >/traces/MySession_<date

Select 'Ok’

1) Click right mouse button on 'Sessions'
) Select 'Create Session..." in the context sensitive menu
3) Enter session name 'MyO!herSessmn
;gnter cuostom path (/tmp/myTraces) for 'Session Path’
elect

1) Click right mouse button on 'Sessions'
2) Select 'Create Session..." in the context sensitive menu

3) Enter session name 'MySession', keep 'Session Path' empty session 'MySession' already exists in the tree.

1) login to the remote host using a command shell

2) type Ittng create newSession and press enter. This will
create a session which is not know by the Control view.
3) Click right mouse button on 'Sessions'

4) Select 'Create Session..." in the context sensitive menu

5) Enter session name MySesslon keep 'Session Path' empty exists on the node. Select 'Details”: Verify that the
k'

) Select '

Select newly created session and click right mouse button

Select newly created session (enable an event before)

a) Eable an event
b) Select session and click on button 'Start'
c) Redo test with context sensitive menu item 'Start'

Select started session and click right mouse button

Select started session

1) In the Control view select session 'MyOtherSession’

2) Click right mouse button

3) select 'Destroy Session..." in the context sensitive menu
4) Select 'Ok’ in the confirmation dialog box

1) Connect to remote host
2) Create new Session 'MyOtherSession'

1) Select session and right mouse click

2) Select menu item 'Enable Channel..."

3) Enter Channel name (e.g. myChanneI) and keep default
values

4) Select Kernel

5) Click on 'Ok’

Verify that menu items are shown and enabled:
'Refresh’, 'Create Session...", 'Execute Command Script

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=| MySesslon)

and time>) and 'State’ (= INACTIVE)

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MyOtherSession)

'Session Path’ (=/tmp/myTraces) and 'State’
(=INACTIVE)

Make sure that an error message appears in the
message area of the dialog box with information that

Verify that an error dialog box will show with information
that command to create a session failed. session already)|

command error detail is shown (with return value (28))

Verify context sensitive menu items:
'Refresh’ (enabled
'Start' (enabled)
'Stop (disabled)
'Destroy Sesslon
‘Import..." (enabl ed)
'Enable Channel..." (enabled)
'Enable Event (default channel)....
'Record Snapshot' (disabled)

' (enabled)

' (enabled)

Verify enable state of view buttons:
'New Connection..." (enabled)
‘Connect' (disabled)

'Disconnect' (disabled)

'Refresh’ (enabled)
'Delete’ (disabled)
'Start' (enabled)
'Stop' (disabled)
'Destroy Session...' (enabled)
‘Import..." (enabled

'Record Snapshot' (disabled)

Verify that Session icon changes to 'ACTIVE' icon. Verify'
that property view shows 'ACTIVE' for the session state

Verify context sensitive menu items:
'Refresh’ (enabled)

'Start' (disabled)

'Stop' (enabled)

'Destroy Sesslon ' (disabled)
‘Import..." (disabled

‘Enable Channel...’ (disabled

)
'Enable Event (default channel)... (disabled)

Verify enable state of view buttons:
'New Connection..." (enabled)
'Connect' (disabled)

'Disconnect' (disabled)

'Refresh’ (enabled)
'Delete’ (disabled)
'Start' (disabled)
'Stop' (enabled)
'Destroy Session...
'Import..." (disabled)

' (disabled)

Verify that session is removed from the control view.

Verify that domain 'Kernel' is created under session and
channel is added under the domain. Verify that default
values for the channel are displayed in the Properties
view after selecting the channel in the tree.

Syscalls look crazy: | think | counted at least 50 events
enabled. -> this is due to per syscall events in 2.6



5.3

5.4

55

5.6

5.7

5.8

6.1
6.2

71

72

73

7.4

75

7.6

7.7

8.1

1) Select domain 'Kernel' and right mouse click
2) Select menu item 'Enable Channel...
Enter Channel name (e.g. MyOtherChanneI)

Enable Channel on domain level (default 4) Change values

values)

Enable Channel — channel already
exists

Domain Context Sensitive menu

Channel Context Sensitive menu

Disable Channel

Enable Channel

UST Channel Handling

Enable Channel on session level
(default values)

Enable/Disable Channel

Kernel Event Handling

Enable Event on session level (all
tracepoints)

Enable Event on domain level (syscalls) 5

Enable Event on Channel level
(Dynamic Probe)

Enable Event on Channel level

(Dynamic Function Probe)

Disable Event

Enable Event

Enable Tracepoint Event using filter in
tree (Bug 450526)

UST Event Handling

Enable Event on session level (all
tracepoints)

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click

2) Select menu item 'Enable Channel'

3) Enter Channel name (e.g. MyOtherChannel) and keep
default values

4) Click on 'Ok’

Select domain 'Kernel' and click right mouse button

Select channel 'MyChannel' and click right mouse button

1) Select channel '"MyChannel' and click right mouse button

2) Select 'Disable' menu item

1) Select channel 'MyChannel' and click right mouse button 2)

Select 'Enable’ menu item

1) Select session and right mouse click
2) Select menu item 'Enable Channel...
3) Enter Channel name 'MyChannel'

4) Select UST

5) Click on Button 'Default'

5) Click on 'Ok’

Redo tests 5.7 and 5.8 with UST channel

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)..."
3) Select 'Kernel'

4; Select Radio button for ‘Tracepoint Events'

5) Select top level tree node 'All'

6) Click on Ok

1) Select domain Kernel and click right mouse button
2) Select menu item 'Enable Events (default channel)..."
3) Select 'Kernel'

4) Select Radio button for 'All Syscalls'

Click on Ok

1) Select a channel (e.g. channel0) and click right mouse
button

2) Select menu item 'Enable Events..."

3) Select Radio button for 'Dynamic Probe"

4) Enter Event Name 'MyEvent' and Probe (e.g. 0xc0101280,

see file /boot/System.map<kernel version>)
5) Click on Ok

1) Select a channel (e.g. channel0) and click right mouse
button
2) Select menu item 'Enable Events..."

3) Select Radio button for '‘Dynamic Function Entry/Return

Probe'

4) Enter Event Name 'MyOtherEvent' and Probe (e.g.
create_dev, see file /boot/System.map<kernel version>)
5) Click on Ok

1) Select multiple events under a channel (not syscalls) and

click right mouse button
2) Select 'Disable' menu item

1) Select multiple disabled events and click right mouse button

2) Select 'Enable’ menu item
1) Create Session

2) Select session, right-mouse click and select 'Enable Events

(default channel)

3) Enter a filter (e.g. sched) for the tracepoint tree and then

select All
4) Click on Ok

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)..."
3) Select 'UST'

4) Select Radio button for ‘Tracepoint Events'

5) Select top level tree node 'All"

6) Click on Ok

Verify that channel is added under the domain. Verify
that correct values for the channel are displayed in the
Properties view after selecting the channel in the tree.

Verify that error dialog box is opened notifying that
channel already exists.

Verify context sensitive menu items:
'Refresh’ (enabled)

'Enable Channel..." (enabled)

'Enable Event (default channel)..." (enabled)
'Add Context...” (enabled)

'Calibrate” (enabled)

Verify context sensitive menu items:
'Refresh’ (enabled)

'Enable Channel' (disabled)

'Disable Channel' (enabled

'Enable Event (default channel)..." (enabled)
'Add Context...” (enabled)

Verify that channel is disabled (disabled channel icon
shown, state DISABLED shown in Properties view, menul
item 'Disable’ is disabled and menu item 'Enable’ is
enabled

Verify that channel is enabled (enabled channel icon
shown, state ENABLED shown in Propemes view, menu
item 'Disable’ is enabled and menu item 'Enable’ is
disabled

Verify that domain 'UST global' is created under session
and channel is added under the domain. Verify that
default values for the channel are displayed in the
Properties view after selecting the channel in the tree.

See 5.7/5.8

Verify that default channel (channel0) is create under
domain 'Kernel' and that all tracepoint events are added
under the channel with state ENABLED.

properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED)

Verify that event with name syscalls is added under the
default channel (channel0) with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree SEvem Type=SYSCALL,
State=ENABLED

Verify that event with name 'MyEvent' is added under the|
respective channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=Probe, State=ENABLED,
Address=0xc0101280, Event Name=MyEven()

Verify that event with name 'MyOtherEvent' is added
under the respective channel with state ENABLED.
Verify properties view show correct values when
selecting a event in the tree (Event Type=Function,
State=ENABLED, Symbol=create_dev, Offset=0x0,
Event Name=MyOtherEvent)

Verify that all selected events are disabled (disabled
event icon is shown, state DISABLED is shown in
Properties view, menu item 'Disable’ is disabled and
menu item 'Enable’ is enabled

Verify that selected events are enabled (enabled event
icon is shown, state ENABLED is shown in Properties
view, menu item 'Disable’ is enabled and menu item
'Enable’ is disabled

Verify that only the selected trace points (filtered) are
enabled and not all UST trace poionts

Verify that default channel (channel0) is create under
domain 'UST global' and that a wildcard event “*”
create under the channel with state ENABLED. Venfy
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED)

Since LTTng Tools 2.2 the event type displayed in the
list command is function instead of probe.

address not allowed Command to change state o
Command failed! Command: Ittng --mi xml enabl
Error Ouptut:

Error: Event myEvent: Non-default channel exists
Return Value:

<?xml version="1.0" encoding="UTF-8"?>

Command to change state of events failed
Command "alled‘ Command: Ittng --mi xml enabl
Error Ouptut:

Error: Event bob: Non-default channel exists withi
Return Value: 83

<?xml version="1.0" encoding="UTF-8"?>




8.2

8.3

8.4
8.5

8.6

9.2

9.3

10.1

10.2

1"

Enable Event on domain level
(wildcards)

Enable Event on Channel level (log
level)

5) S
Enable Event on Channel level (log level 6

oly)
Enable/Disable Event

Enable Tracepoint Event using filter in
tree (Bug 450526)

Contexts Handling

Add Context (to channel)

Add Context (to channel)

Add Context (to event)

Enable Events (from Provider)

Enable Kernel Events

Enable UST Events

Importing to Project

1) Select domain 'UST global' and click right mouse button
2) Select menu item 'Enable Events (default channel)..."
3) Select Radio button for 'Wildcard'

4) Enter a wildcard (e.g. ust*)

5) Click on Ok

11)) t?elect a channel (create if necessary) and click right mouse
utton

2) Select menu item 'Enable Events..."

3) Select Radio button for 'Log Level'

4) Enter Event Name 'MyEvent'

5) Select log level TRACE_ERR

6) Select radio button for loglevel

7) Click on Ok

1) Select a channel (create if necessary) and click right mouse
button
2) Select menu item 'Enable Events..."
3) Select Radio button for 'Log Level'
4) Enter Event Name 'MyOtherEvent'
elect log level TRACE_INFO
Select radio button for loglevel-olny
7) Click on Ok
Redo tests 7.5 and 7.6 with UST events
1) Create Session
2) Select session, right-mouse click and select 'Enable Events
default channel)'
3) Enter filter for the tracepoint tree and then select All
4) Click on Ok

1) Select kernel channel and click rlghl mouse button
2) Select menu item 'Add Contexts...
3) Expand tree and select some contexts (e.g prio, pi

Verify that event with wildcarded name (e.g ust*) is
added under the default channel (channel0) with state
ENABLED. Verify properties view show correct values
when selecting a event in the tree (Event
Type=TRACEPOINT, State=ENABLED)

Verify that event with name 'MyEvent' is added under the|

respective channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
TRACE ERR, Event
Name=MyEvent)

Verify that event with name 'MyOtherEvent' is added
under the respective channel with state ENABLED.
Verify properties view show correct values when
selecting a event in the tree (Event Type=TRACEPOINT,
State=ENABLED, Log Level= ==TRACE_INFO, Event
Name=| MyOtherEvent)

See 7.5/7.6

Verify that only the selected trace points (filtered) are
enabled and not all UST trace poionts

4) Cllck on 'Ok’

1) Select UST channel and click nght mouse button
2) Select menu item 'Add Contexd
3) Expand tree and select contexts | procname pthread_id, vpid

4) Cllck on 'Ok’

1) Select 1 Kernel tracepoint event and click right mouse

button
2) Select menu item 'Add Contexts...
3) Expand tree and select some contexts (e.g prio, procname,

4) Cllck on 'Ok’
Note: only when using LTTng Tools 2.0.x - 2.1.x. For v2.2 or
later this menu item has to be disabled

1) Create a new session

2) Select multiple Kernel Tracepoint events under Providers —
Kernel

3) click right mouse button

4) select menu item 'Enable Event..."

5) Select newly created session

6) Select 'Ok’

1) Make sure that UST application is running on remote host
(see step 0)

2) Create a new session

3) Create a channel under domain 'UST global'

4) Select multiple UST Tracepoint events under Providers ->
<UST Process>

5) click right mouse button

6; select menu item 'Enable Event..."

7) Select newly created session

8) Select newly created channel

9) Select 'Ok’

Verify that is successful (no error).
NOTE: There is no way to retrieve added contexts from
the trace. Therefore GUI cannot display this information.

Verify that command is successful (no error).

NOTE 1: There is no way to retrieve added contexts
from the trace. Therefore GUI cannot display this
information.

NOTEZ2: For UST only contexts procname, pthread_id,
vpid and vtid are supported

Verify that command is successful (no error).
NOTE: There is no way to retrieve added contexts from
the trace. Therefore GUI cannot display this information.

Verify that domain 'Kernel' is created under the new
session. Verify that default channel 'channel0' is created
under the domain. Verify that selected events are added
under the channel and are ENABLED.

Verify that selected events are added under the selected
channel and are ENABLED.

Note: In LTTng backend v2.4 and later prowde
information if a loglevel is for a range (e.
TRACE_ERR) This will be displayed by the propemes
view now

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a single level (e.g. ==
TRACE_INFO) This will be displayed by the properties
view now

duplicated event, and gives a failure.

Command to change state of events

failed

Command failed! Command: Ittng --mi

xml enable-event log -u -s

MyOtherSession -¢c Grimace --tracepoint

Error Ouptut:

Error: Event log: UST event already

enabled (channel Grimace, session

MyOtherSession)

Return Value: 55

<?xml version="
2>

.0" encoding="UTF-

<command><name>enable-

output nt:
<name>log</name><type>TRACEPOIN
T</type><enabled>false</enabled><filter
>fa|se</f |ter><excIusnon>faIse</exclus|o
false</st /event
loutput><succ
ss></command>

Per event adding of context is not supported by LTTng

N/A  Tools anymore (starting from LTTng 2.2)




1) Create new session
2) Enable all Kernel Tracepoint events
3) Enable all Kernel sycalls
4) Enable all UST events
5) Start Tracing
6) Stop Tracing after a few seconds
11 P 7) Create new Tracing Project
After 2 verify that all traces are selected by default and
also that the tracing project with name 'Remote’ is
selected.
Verify that during import a progress dialog is opened to
show the progress of the import operation.
Verify that traces are imported to the project wiith name
Remote and its Traces folder. Verify that for the kernel
trace the trace type "LTTng Kernel Trace” is set and for
the UST traces the trace type "LTTng UST Trace" is set.
1) Select session from 11.1 and click right mouse button Create Experiment, select all traces and open
2) Select 'Import..." Experiment. Make sure that all view are populated
11.2  Import to project 3) Select Ok correctly in the LTTng Kernel Perspective.
1) Repeat step 1 — 3 of test case 11.2
2) In dialog box select 'Overwrite existing traces without
warning' Verify that traces are imported and existing traces are
11.3  Import to project (Overwrite) 3) Select Ok overwritten
1) Repeat step 1 — 3 of test case 11.2
2)Select Ok
3) For each trace a confirmation dialog will open:
Select 'Rename’ and change trace name
11.4  Import to project (Rename) 4) Select 'Ok’ Verify that traces are imported with a different name
1) Repeat step 1 — 3 of test case 11.2
2)Select Ok
3) For each trace a confirmation dialog will open:
Import to project (Overwrite Select 'Overwrite' Verify that traces are imported and existing traces are
11.4  Confirmation) 4) Select 'Ok’ overwritten
L
Press refresh button and context sensitive menu item for
12.1 Refresh different selections Verify that the Control View is refreshed.
L]
1) Create new session
2) Enable all Kernel Tracepoint events
3) Enable all Kernel sycalls
4) Enable all UST events
13.1 P
1) Start Tracing Verify that Calibrate command is executed without error.
2) Select Domain 'Kernel' and click right mouse button he test case is To Doed if no Error occurred.
3) Select menu item Calibrate See also calibrate section in liNk below for a Use Case of
4) Redo step 2-3 with domain 'UST global' That feature. http://lting.org/files/doc/man-
13.1 Calibrate 5) Stop tracing pages/man1/iting. T.htm
L]
For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
14.1 tests/hello.cxx)
1) Connect to remote host
142 Preparation 2) Create new Session 'FilterSession'
1) Select session and click right mouse button Verify that default channel (channel0) is create under
2) Select menu item 'Enable Events (default channel)..." domain 'UST global' and that the corresponding event is
3) Select 'UST' created under the channel with state ENABLED.
4) Select Radio button for 'Tracepoint Events'
5) Select one tracepoint Verify that Properties view shows correct values for this
6) Enter filter expression on a event field event (Event Type=TRACEPOINT, State=ENABLED,
14.3  Enable UST Event on session level 7) Click on 'Ok’ Filter=with filter)
1) Execute 14.3
2) Select one UST Tracepoint event under Providers -> <UST
Verify that selected event is added under the selected
3) click right mouse button channel.
4) select menu item 'Enable Event...'
5) Select newly create session and channel Verify that Properties view shows correct values for this
6) Enter filter expression on a event field event (Event Type=TRACEPOINT, State=ENABLED,
14.4  Enable UST Event from provider 7) Click on 'Ok’ Filter=with filter)
1) Start Tracing
2) Stop Tracing after a view seconds
3) Import Trace to Project
4) Open Trace Make sure that only events are shown in the events
145  Create trace 5) Destroy Session table that met the condition in the filter expressions



http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html

15.1

15.2

15.3

15.4

15.5

15.6

15.7

15.8

15.9

15.10

15.11

Create Session Dialog - Advanced
Button

Create Session Dialog - Check box "Use
same protocol and address for data and
control"

Create Session Dialog - Protocol list

Create Session Dialog - Protocol list 2

Create Session Dialog - Protocol
propagation

Create Session Dialog - Address
propagation

Create Session Dialog - Protocol
propagation 2

Create trace with file protocol

Create trace with file protocol and trace
path

Create trace with net protocol

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST

process running (e.g. from Ittng-tools git repository under
(ests/hello CXX)

1) Open Create Session Dlalog box
2) Select "Advanced >>>'
3) Select "<<< Basic"

1) Open Create Session Dialog box and select "Advanced

2) Uncheck checkbox"Use same protocol and address for data
and control"

3) Check checkbox "Use same protocol and address for data
and control"

1) Open Create Session Dialog box and select "Advanced
>>>"

1) Open Create Session Dialog box and select "Advanced

2) Uncheck checkbox "Use same protocol and address for
data and control"

1) Open Create Session Dialog box, select "Advanced >>>"
2) Select net6 for Control Protocol
3) Select file for Control Protocol

1) Open Create Session Dialog box, select "Advanced >>>"
2) Enter IP address

1) Open Create Session Dialog box and select "Advanced
>>>"

2) Uncheck checkbox "Use same protocol and address for
data and control"
3) Select tcp for control protocol and tcpé for data protocol

) Check checkbox "Use same protocol and address for data
and control"

1) Open Create Session Dialog box and select "Advanced
>>>"

2) Enter session name, select file protocol and enter directory
ItmpltestTraces/ in address field and press ok

3) Enable events, start tracing, wait for a few seconds, stop
tracing

4) Import traces to a existing tracing project

5) Destroy session

1) Open Create Session Dialog box and select "Advanced
>>>"

2) Enter session name, select file protocol and enter directory
/tmp/tmpTraces/ in address field, enter /newPath in "Trace
Path” text field and press ok

3) Enable events, start tracing, wait for a few seconds, stop
tracing

4) Import traces to a existing tracing project

5) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-
2y

2) Open Create Session Dialog box and select "Advanced

>>>"

3) Enter session name, select net protocol and enter IP

After 2) verify that advanced options are shown (e.g.
Trace Path, Protocol, Address and Port)

After 3) verify that advanced option are not shown and

only basic options are there (Session Name and Session!

Path)

After 2) verify that data Protocol and data Address is
enabled. Note that the ports cannot be configured for net
and net6 when this button is unchecked. -> port text
fields are disabled

After 3) Verify that data Protocol and data Address are
disabled

Verify that the data protocol dropdown menu shows net,
net6 and file

After 2) verify that the data protocol dropdown menu
shows net, net6, tcp and tcp6

After 2) verify that net6 is propagated to the data
protocol and and that the data and control port text fields
are enabled

After 3) verify that file is propagated to the data protocol

and that the data and control port text fields are disabled.

After 2) verify that the IP address is propagated to the
data address field

After 4) make sure that both data and control protocol
show net

Verify that the traces are stored on the remote host
under /tmpl/testTraces/<session name + date>/kernel
and /tmp/testTraces/<session name +
date>/ust/<application(s)> repectively.

After 2) make sure that the Session Path in the Property
View shows the URL with the configured parameters

Verify that the remote import dialog box opens at step 4
(as described in test cases 11.x) and it is possible to
transfer the traces to the tracing project.

Verify that the traces are stored on the remote host
under /tmp/testTraces/newPath/kernel and
ItmpltestTraces/newPath/ust/

repectively.

After 3) make sure that the Session Path in the Property
View shows the URL with the configured parameters

Verify that the remote import dialog box opens at step 4
(as described in test cases 11.x) and it is possible to
transfer the traces to the tracing project.

Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/Ittng-traces/<remote
machine nam ion name + d: kernel and
/home/<user name>/lttng-traces/<remote machine
name>/<session name + date>/ust/<application(s)>
repectively.

After 3) make sure that the Session Path in the Property
View shows the URL with the configured parameters

address of Eclipse local machine in address field and press ok After 5) Verify that dialog box for selecting a tracing

4) Enable events, start tracing, wait for a few seconds, stop
tracing

5) Import traces to a existing tracing project

6) Destroy session

project is openend that after selecting a project and
pressing next the default trace import wizard opens.
Then verify that it is possible to transfer the traces to the
tracing project.

After import the root directory is newPath. However |
expected tmpTrace with sub-dir newPath. Needs to be
investigated



15.12

15.13

15.14

16.1
16.2
16.3

16.4

16.5

16.6

16.7

16.8

16.9

16.10

16.11

171

17.2

1) Uncheck checkbox "Use same protocol and address for
data and control"

Verify that the traces are stored on the Eclipse local

machine under /home/<user name>/lltng-tracesl<remote
machine nam ion name + el an
/home/<user name>/lttng-traces/<remote machine

2 ) Start relayd on Eclipse Iocal machlne with i
(Ittng-relayd -C tcp://0.0. D tcp://0.0.0.0:! 5678)

3) Open Create Sessmn Dlalog box and select "Advanced
>>>"

4) Enter session name, select tcp protocol and enter IP
address of Eclipse local machine in address field, specify data
and control ports and press ok

5) Enable events, start tracing, wait for a few seconds, stop
tracing

6; Import traces to a existing tracing project

7) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Select Live Mode

3) O"pen Create Session Dialog box and select "Advanced

Create trace with tcp protocol and port

4) Enter session name, select net protocol and enter IP
address of Eclipse local machine in address field, keep
defaults for Live Connection and Live Delay, and press ok
5) Enable UST events (per UID channel), start tracing, wait for
a few seconds, stop tracing
6) Import traces to a existing tracing project
) Destroy session
1)|Stg;l relayd on Eclipse local machine (default settings: Ittng-
rela)
2) Select Live Mode
3) Open Create Session Dialog box and select "Advanced
>>>"

Live Streaming Session (UST) - Initial

implementation

4) Enter session name, select net protocol and enter IP
address of Eclipse local machine in address field, keep
defaults for Live Connection and Live Delay, and press ok
5) Enable Kernel events, start tracing, wait for a few seconds,
stop tracing
Inititial 6) Import traces to a existing tracing project
) Destroy session

Live Streaming Session (Kernel) -
Implementation

Preferences

Open Preferences (Menu -> Preferences -> Tracing -> LTTng
Tracer Control Preferences)

In Tracer Control Prferences, check checkbox Logging
In Tracer Control Prferences, uncheck checkbox Logging

Execute 16.2 and execute some commands (e.g. create
session, enable event)

Open Preference Dialog
Enable Logging
Disable Logging

Test Logging level none

1) Execute 16.2

2) select verbose level Level 1

3) Execute some commands (e.g. create session, enable
event)

1) Execute 16.2

2; select verbose level Level 2

3) Execute some commands (e.g. create session, enable
event)

1) Execute 16.2

2) select verbose level Level 3

3) Execute some commands (e.g. create session, enable
event)

Test Verbose Logging (Level 1)

Test Verbose Logging (Level 2)

Test Verbose Logging (Level 3)

Check checkbox Append, restart Eclipse and open Tracer

Append Mode Control Preferences

Change Tracing group (e.g. tracing2) and execute a command

Change Tracing Group (while logging enabled)
Change execution timeout Change Execution Timeout
Reset Reset to defaults

Create Channel with advance features
(LTTng 2.2 features)

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx).

Create and select session and click nght mouse button
2) Select menu item 'Enable Channel...

3) Select Checkbox 'Configure metadata channel

4) Update all text boxes

)
Configure Metadata channel (kernel) 5) Click on 'Ok’

ion name + date>/ust/<application(s)>

repectively.
After 4) make sure that the Session Path in the Property
View shows the URL with the configured parameters

After 6) Verify that dialog box for selecting a tracing
project is openend that after selecting a project and
pressing next the default trace import wizard opens.
Then verify that it is possible to transfer the traces to the
tracing project.

Verify that session is created successfully. Verify that
after 6) the trace appears in the Traces directory of
Remoter project. Verify that relevants views are updated
when new data arrives

No way to specify destination in tracing project.
No check for name collision of the trace name
Not possible yet to trace per PID

XML Analysis view cannot be opened

Verify that session is created successfully. Verify that
after 6) the trace appears in the Traces directory of
Remoter project. Verify that relevants views are updated

when new data arrives Performance needs to be investigated.

Verify that tracer control preferences exists and shows
Tracing Group, Logging, Log File (always disabled),
Append, Verbose Level (None, Level 1, Level2 Level 3)

Verbose Level radio buttons will be enabled
Verbose Level radio buttons will be disabled

Make sure that log file is created and contains the
executed commands and command replies

Make sure that log file contains the executed commands
with -v option (e.g. Ittng -v create session) and the

command replies come with debug information This makes no difference for Lttng 2.6 in mi mode

Make sure that log file contains the executed commands
with -vv option (e.g. Ittng -vv create session) and the

command replies come with debug information This makes no difference for Lttng 2.6 in mi mode

Make sure that log file contains the executed commands
with -vvv option (e.g. Ittng -vvv create session) and the

command replies come with debug information This makes no difference for Lttng 2.6 in mi mode

Verify that tracer control preferences are persisted and
the log file is opened in append mode (old file is not
overwritten)

Verify that Ittng command is executed with command line|
option -g <group>. Ignore any command reply errors (if
any)

After verify that values smaller than 5 and bigger than
600 are rejected

Incorrect command-line was build (Bug 459444)

Verify: ging Append is
deselected, Verbcse Level None) and Command
Timout is 15

Verify after 3) that 'Channel Name' is set to metadata
and the correspondig textbox is disabled. Verify after 5)
that metadata channel was created under the kernel
domain. Also verify in the properties view that all
parameters are set correctly when selecting the channel
metadata.



17.3

17.4

17.5

17.6

17.7

17.8

17.9

18

18.1
18.2

18.3

18.4

18.5
18.6
18.7

Configure Metadata channel (UST)

Configure File rotation (kernel)

Configure File rotation (ust)

Buffer Type - toggle UST/kernel

Default UST Buffer Type

per PID UST Buffer Type

per UID UST Buffer Type
Snapshot Channel (LTTng 2.3
features)

Preparation

Create Snapshot Session
Enable Kernel Event

Start Session

Record snapshot

Create another snapshot session
Enable UST Events
Start UST session

1) Re-do 17.2 with a UST channel

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'
3) Fill in channel name

4) Fill in 1048576 in 'Maximum size of trace files' and also 'Sub

Buffer Size'

5) Fill in 2 in 'Maximum number of trace filesfiles'
6) Click on 'Ok’

7) Enable all kernel events

8) Start, wait and stop tracing.

1) Create and select session and click rlght mouse button
2) Select menu item 'Enable Channel.
3) Fill in channel name
4) Select UST
5) Fill in 262144 in 'Maximum size of trace files' and also 'Sub
Buffer Size'
6) Fill in 2 in 'Maximum number of trace filesfiles'
7) Click on 'Ok’
8) Enable all UST events
9) Start, wait and stop tracing.

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'

3) Select UST

4) Select Kernel

5) Slect cancel

1) Create and select session and click nght mouse button
2) Select menu item 'Enable Channel...
3) Select UST

4) Enter Channel Name

5) Select 'Ok’

Prequisite: Multiple UST Applications need to run

1) Create and select session and click nght mouse button
2) Select menu item 'Enable Channel...

3) Select UST

4) Select 'Per PID buffers'

5) Enter Channel Name

6) Select 'Ok

8) Enable all ust events

9) Start, wait and stop tracing.

10) Import trace

Prequisite: Multiple UST Applications need to run

1 Create and select session and click right mouse button
2) Select menu item 'Enable Channel..."

3) Select US

4) Select 'Per UID buffers'

5) Enter Channel Name

6) Select 'Ok’

8) Enable all ust events

9) Start, wait and stop tracing.

10) Import trace

Connect to a node with LTTng 2.3 installed

1) Click right mouse button on 'Sessions'
2) Select 'Create Session..." in the context sensitive menu

3) Enter session name 'MySesslon keep 'Session Path’ empty

4) Select checkbox 'Snapshot Mode'
5) Select 'Ok

Enable all Kernel Tracepoint and syscall events

a) Select session and click on button 'Start'
b) Redo test with context sensitive menu item 'Start'

select session and record 2 snapshots: Once with button
'Record Snapshot' and once with context-sensitive menu item
'Record Snapshot'

session name ustSession (as described in 18.1)

Enable all UST events

see 18.3

Verify after 3) that 'Channel Name' is set to metadata
and the correspondig textbox is disabled. Verify after 5)
that metadata channel was created under the domain
UST global. Also verify in the properties view that all
parameters are set correctly when selecting the channel
metadata.

After 8) verify on the trace node that trace files are not
bigger than 1048576 bytes

After 9) verify on the trace node that trace files are not
bigger than 262144 bytes

Verify after 2 and 4 that the radio buttons for the buffer
type is disabled and the buffer type "Global shared
buffers" is selected which is the value for the kernel
tracer.

Verify after 3) that the radio buttons are enabled an no
buffer type is selected

Verify after 5) that the default buffer type is configured
for that channel (see properties view). Note for LTTng
Tools 2.2 the default is per-PID and for LTTng Tools 2.3
and later it is per-UID

Verify after 6) that the per-pid buffer type is configured
for that channel (see properties view). After 10) make
sure that for each UST application one trace is created

Verify after 6) that the per-pid buffer type is configured
for that channel (see properties view). After 10) make

sure that only one trace is created even multiple UST

applications are running.

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MySession)

'Snaphshot ID' (=1

'Snapshot Name' (=snapshot-1)

'Session Path' (=/home/<user>/traces/MySession_<date
and time>) and 'State’ (<INACTIVE)

Make sure that the button and menu item 'Record
Snapshot' is disabled

Verify that channel and events a successful enabled

Verify that Session icon changes to 'ACTIVE' icon. Verify:
that property view shows 'ACTIVE' for the session state

Make sure that the button and menu item 'Record

Snapshot' is enabled. Also make sure that the Button
and menu item 'Import' is enabled.

Commands succeed without error

Make sure that snapshot session is created successfully
Verify that channel and events a successful enabled
see 18.3

Command is successful. However tracer doesn't create
metadata channel

Kernel trace is generated corretly with LTTng 2.5.4

eclipse.

and

eclipse.

While doing this | found a few bugs but it ended up working. See

/_bug.cgii

/_bug.cgii



18.8

18.9

18.10

18.11

19.1

Select kernel and ust session (see 18.1 and 18.5) and click on
Record snapshot over multiple sessions 'Record snapshot' button

Import traces Open Import dialog (see 11.2)

Stop and destroy sessions Stop and destroy both sessions

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Open Create Session Dialog box, select 'Snapshot
Mode'and select "Advanced >>>"

3) Enter session name, select net protocol and enter IP

address of Eclipse local machine in address field and press ok

4) Enable events (UST and Kernel), start tracing, and recored
a few snapshots, stop tracing
5) Import traces to a existing tracing project

Network snapshot session 6) Destroy session

Command Script
Create a command script to create a session with kernel and

Execute command sript ust events enabled.

;ommand succeeds without error

Verify that 4 snapshots are available (3 kernel and 1
UST). Verify that all snapshots are imported to the
selected tracing project

Verify that sessions are destroy successfully

Make sure that all steps were successfull. Also, import
the traces using the standard import instead of the

Ittng-consumerd crashed after a couple of snapshots but
remote import

everything worked on Trace Compass side

Make sure that each command of script is executed and
script execution is without errors




Section ToDo Comment

GDB Tracing
Target: Ubuntu 15.04 64 bit

Step Test Case Action Verification Comment

1 Preparation

1.1 Step 1 Open and reset the GDB Trace perspective GDB Trace perspective opens with correct views Pass
1.2 Step2 Open Navigator View (used for independent verification) Navigator View opens Pass
2 Project Creation

2.1 New Project Wizard Open New Tracing Project Wizard Tracing Project Wizard opens Pass

2.2 Create project Specify a project name and finish Tracing project appears in Project Explorer Pass

23 Project structure Close and open the new Tracing project Project contains the Traces folder Pass
3 Traces Folder

3.1 Traces Folder menu Select the Traces folder and open its context menu Correct menu opens (Open Trace, Import, New Folder, ...) Pass

3.2 Trace Import Wizard Select Import Trace Trace Import Wizard appears Pass

33 Import traces Select a GDB Trace from samples directory and finish Imported traces appear in Folders with proper icon Pass

4 Trace Configuration
Verify that an Error Dialog opens that notfiies the user to select
4.1 Project/executable selection Double-click on an un-configured trace the trace executable Pass

1) Right mouse click on trace
2) Select menu item "Select Trace Executable"

4.2 Select Trace Executable 3) Fill in the proper values in dialog and finish Trace is configured (4.3 is successful, when 4.2 was successful) Pass
4.3  Open configured trace Double-click on a configured trace Trace is opened, events table and views are populated Pass
5 Source Code Lookup
The corresponding source code location is selected in the source
5.1 Select event With mouse select an event in events table code file. Pass
The corresponding source code location is selected in the source
5.2  Select another event redo 5.1 code file. Pass
6 Events Table Navigation

Each keystroke modifies the selected event and the corresponding
6.1 Arrow keys Update the current event using up/down keys within window source code location is selected in the source code file. Pass

Table is refreshed to display new current event and the
corresponding source code location is selected in the source code

6.2  Scrolling Update the current event using up/down keys outside windo file Pass
6.3 PgUp/PgDn Update the current event using PgUp/PgDn keys Table is scrolled accordingly Pass
Table jumps from first to last event and the corresponding source

6.4 Home/End Update the current event using Home/End keys code location is selected in the source code file Pass
7 Events Searching & Filtering

7.1 Search In the search bar, enter some RE Events corresponding to the RE are highlighted Pass  Color issues on GTK3, https://bugs.eclipse.org/bugs/show_bug.cgi?id=467933

7.2 Navigation Navigate through highlighted events using Enter/Shift-Enter Next/previous highlighted event selected accordingly Pass

7.3 Un-search In the search bar, clear the RE Events are displayed normally Pass

7.4 Filter In the filter bar, enter some RE Only events matching RE are displayed Pass

7.5 Un-filter Ithe filter bar, clear the RE Events are displayed normally Pass

7.6 Filter & Search In the filter bar, enter some RE; likewise in the search bar Events are filtered and highlighted accordingly Pass

7.7 Search &Filter In the search bar, enter some RE; likewise in the filter bar Events are filtered and highlighted accordingly Pass
8 Events Synchronization

8.1 Synch from Events View Click on an event in the Events View Trace Control View is updated; Debug View is updated Pass

8.2 Synch from Trace Control Go up/down from the Trace Control View Events View is updated accordingly Pass



Section Pass Fail
Tracing RCP 32
Target: Ubuntu 15.04
Step Test Case Action Verification
1 Start RCP
1.1 Start Tracing RCP Open RCP from command line or file explorer Tracing RCP opens in default perspective
Start Tracing RCP with text ~ Open RCP from command line with --open <trace name with
1.2 trace absolut path> Trace will be opened with auto-detected trace type
Start Tracing RCP with Open RCP from command line with --open <trace name with  Verify that the same trace that was previously linked into the
1.3 previously opened text trace absolut path>. Use same trace than 1.2 Traces folder is opened and not a new trace entry is created
Start Tracing RCP with Kernel Open RCP from command line with --open <kernel trace Tracing RCP is opened, the trace is linked to the Tracing project,
1.4 CTF trace name with absolut path> the kernel analysis trace type is selected and trace is opened.
Start Tracing RCP with
previously opened Kernel CTF Open RCP from command line with --open <kernel trace Verify that the same trace that was previously linked into the
1.5 trace name with absolut path>. Use same trace than 1.4 Traces folder is opened and not a new trace entry is created
Open RCP from command line with --open <trace name with  Verify that a new trace is linked to the Tracing project and trace is
Start Tracing RCP with new absolut path>, where the name of trace is the same than 1.2, opened. Verify that the new trace name has a integer number a
1.6 trace with name conflict but the trace is located at a different location on disk suffix added.
Open RCP from command line with --open <kernel trace with Verify that a kernel trace is linked to the Tracing project, the
absolut path>, where name of trace is the same than 1.4, but kernel analysis trace type is selected and trace is opened. Verify
1.7 Re-do 1.6 the trace is located at a different location on disk that the new trace name has a integer number a suffix added.
Start Tracing RCP with non-
1.8 trace file Open file that is not a trace Trace is imported (linked) however default icon (From Eclipse) is set!
2 File menu
Use Menu "File -> Open Trace ..." In the file dialog select a
2.1 Open Trace (File) text trace and select open. Trace will be opened with auto-detected trace type
Open Trace (File) with Use Menu "File -> Open Trace...". In the file dialog select a Verify that the same trace that was previously linked into the
2.2 previously opened text trace text trace and select open. Use same trace than 2.1 Traces folder is opened and not a new trace entry is created
Use "Menu File -> Open Trace ..." . In the file dialog selecta  Verify that the trace is linked to the Tracing project, the kernel
2.3 Open Trace (Directory) file of Kernel CTF trace directory and select open. analysis trace type is selected and trace is opened.
Open Trace (Directory) with  Use "Menu File -> Open Trace ..." . In the file dialog select a
previously opened Kernel CTF file of Kernel CTF trace directory and select open. Use same Verify that the same trace that was previously linked into the
2.4 trace trace than 2.3 Traces folder is opened and not a new trace entry is created
Use Menu "File -> Open Trace ..." In the file dialog select a
text trace and select open, where the name of trace is the Verify that the new trace is linked to the Tracing project and the
Open Trace File with name same than 2.1, but the trace is located at a different location trace is opened. Verify that the new trace name has a integer
2.5 conflict on disk number a suffix added.
Use "Menu File -> Open Trace ..." . In the file dialog select a
file of Kernel CTF trace directory and select open, where the Verify that the kernel trace is linked to the Tracing project, the
name of trace is the same than 2.3, but the trace is located at kernel analysis trace type is selected and trace is opened. Verify
2.6 Re-do 2.5 a different location on disk that the new trace name has a integer number a suffix added.
2.7 Open file Open file that is not a trace Trace is imported (linked) however default icon (from Eclipse) is set
Verify that RCP is restarted with the previously open perspective
2.8 Restart Use Menu File -> Restart and trace
2.9 Exit Use Menu File -> Exit Tracing RCP exits
3 Window Menu
Use Menu Window -> Show Perspective -> Tracing
31 Open Perspective Perspective Tracing perspective is opened

To Do

Comment

[ o |

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Comment

The kernel trace opens in an editor but the editor of the first trace
gets activated. Bug 443461.



3.2
33

3.4

3.5

4.1

4.2

4.2

44

4.5

5.1

5.2

5.3
5.4

6.1

Open View
Preferences

Save Perspective As

Reset Perspective

Help Menu

Help Contents

Help Contents (shortcut)
Install new Software
About

Version + Copyright
Content
TMF presence

LTTng presence
PCAP Network analysis
presence

BTF presence

Upgrade

Upgrade from previous
release

Use Menu Window -> Show View -> Select Tracing ->

Sequence Diagram
Use Menu -> Preferences

Make changes of perspective by moving views and use menu
Window -> Save Perspective As. Enter a perspective name

and select Ok

Make changes of perspective by moving views and use menu
Window -> Reset Perspective.

Use Menu -> Help -> Help Contents

Use key F1

Use Menu -> Help -> Install New Software... to install new

Eclipse feature

Use Menu -> Help -> About

Use Menu -> Help -> About -> Installation details

Open Tracing perspective

Open LTTng Kernel perspective

Open Network analysis perspective

Open BTF trace

Use Help -> Check For Updates

Sequence diagram view is shown
Preferences dialog is shown

Perspective with new name is stored

After confirming the reset operation the perspective is reset to the
default layout.

Help content browser is opened. All Tracing related help is
included

Help content browser is opened. All Tracing related help is
included

Installation is successful

About dialog is opened all relevent information (e.g. version,
copyright years etc) is up-to-date and correct.

Go over all tracing features and plug-ins and verify that all have the
correct version and copyright years

Tracing perspective opens
LTTng Kernel perspective opens

Network analysis perspectiv opens
BTF trace opens correctly

RCP is upgraded



Target:

Step

0

0.1

0.2

0.3
0.4

1.1

1.2

1.3

1.4

1.5

21

22

2.3

24
25

2.6

3.1

3.2

Section

LTTng 2.0 - Memory
Analysis

Test Case

Prerequisites

Download traces

Import trace with memory
event

Import trace without
memory event

Import non-UST trace

Project View

Check analysis can
execute

Pass

Action

Download UST trace with memory events
from
http://secretaire.dorsal.polymtl.ca/~gbastien
/traces/eclipse_mem_ust.tar.gz

Import the LTTng UST trace downloaded
above in Tracing project

Import one of the LTTng UST trace that
does not contain the memory events, for
example, the one used for the callstack
view

Import one LTTng Kernel trace

In the project explorer, expand the trace
that contains the memory events

In the project explorer, open and expand
the trace that contains the memory events,

Verify help message when right-click the memory analysis and select

applicable

Check analysis cannot
execute

Help

In the project explorer, expand the UST
trace that does not contain memory events
In the project explorer, open and expand
the UST trace that does not contain

Verify help message when memory events, right-click the memory

not applicable

analysis and select Help

Check analysis for another In the project explorer, expand a LTTng

trace type
View Management

Populate analysis's view

Open view

Close trace

Open trace
Close view

Re-open view
Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Kernel trace

Open the UST trace with memory events
and expand the "UST Memory" analysis in
the project explorer

Double-click the UST Memory View under
the memory analysis

Close the trace

With the view already opened, open the
trace

Close the UST Memory Usage view

Double-click the UST Memory Usage view
under the memory analysis in project
explorer.

Drag move xy chart left and right with
middle button

Zoom with mouse wheel up and down,
cursor inside xy chart

Fail

Verification

"Ust Memory" analysis is present and "normal"

A generic help message appears with the name of the
analysis.

"Ust Memory" analysis is present, but striked-out

The help message mentions the analysis is impossible to
execute and contains the requirement that is not fulfilled

"Ust Memory" analysis is not present

"Ust Memory Usage" View appears under the analysis

The UST Memory Usage view opens and triggers the memory
analysis. After the analysis, the XY chart is populated

The UST Memory Usage view is emptied.

The UST Memory Usage view is populated.
The view is closed.

The view opens and is automatically populated.

Time range is dragged. When mouse button is released, the
view refreshes with the new time range

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views.

To Do

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Comment

Comment

Axises need to be cleared

https://bugs.eclipse.org/bugs/show_bug.cgi?id=

469644

But while dragging, nothing visible happen



3.3
34

3.5

3.6

4.1

4.2

4.3

Drag select time range Drag select time graph with right button

Mouse hover Hover mouse in xy chart anywhere

Drag mouse selection Drag select xy chart with left button

Click select with left button (begin time),

press shift key and click select another time most selected time and delta the time difference between T2-

Shift key selection (end time)

Synchronization

Have the Histogram and UST Memory
Preparation Usage views both visible
Select a random time in another view

Select a new time range in UST Memory
Time range synchronization Usage view or in Histogram view.

Time synchronization

In any other view that supports range

Time range selection
synchronization, select a new range.

synchronisation

Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new time
range is propagated to other views.

Tool tip shows values for each thread at the given timestamp

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right
most selected time and delta the time difference between T2-
T1

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right

Status bar is not updated

Second click-select just select the timestamp,
no range

Selected time line is updated. If selected time is outside current

range, time range is updated to include it. Clicking outside range does not work

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time
range is outside the current range, then time range is

updated to include it View does not include T1 outside current range



Section Pass Fail ToDo Comment

LTTng 2.0 - CPU Analysis 21 | o |7

Target:
Step Test Case Action Verification Comment
0 Prerequisites
0.1 Import traces Import LTTng Kernel traces in Tracing project
1 Project View
Check analysis can In the project explorer, expand a LTTng
1.1 execute Kernel trace "CPU usage" analysis is present and "normal" Pass

In the project explorer, open and expand the
Verify help message when LTTng kernel trace, right-click the CPU usage A generic help message appears with the name of the

1.2 applicable analysis and select Help analysis Pass
Check analysis for another In the project explorer, expand a non-LTTng

1.5 trace type Kernel trace "CPU usage" analysis is not present Pass

2 View Management

Open an LTTng kernel trace and expand the
21 Populate analysis's view  "CPU usage" analysis in the project explorer "CPU Usage" View appears under the analysis Pass
The CPU usage Usage view opens and triggers the cpu
Double-click the CPU usage View under the  analysis. After the analysis, both tree viewer and xy charts

2.2 Open view CPU usage analysis are populated. Pass
axises need to be reset
X X X https://bugs.eclipse.org/bugs/show_bug.cgi?id
23 Close trace Close the trace The CPU Usage view is emptied. =469644
2.4 Open trace With the view already opened, open the trace The CPU Usage view is populated. Pass
25 Close view Close the CPU Usage view The view is closed. Pass
Double-click the CPU Usage view under the
2.6 Re-open view CPU usage analysis in project explorer. The view opens and is automatically populated. Pass
3 View selection
A new series is added to the xy chart, corresponding to the
3.1 Select an entry Select an entry in the tree viewer section selected TID Pass
A new series is added to the xy chart, and the previous TID's,
3.2 Select another entry Select another entry from the tree viewer series is not displayed anymore Pass
4 Mouse handling

Time range is dragged. When mouse button is released,
Drag move xy chart left and right with middle series are updated and new time range is propagated to
4.1 Drag move time range button other views. Pass But while dragging, nothing visible happens

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views,
Zoom time range (mouse Zoom with mouse wheel up and down, cursor including the tree viewer beside the chart. The selected
4.2 wheel) inside xy chart process remains the same. Pass

Scroll with mouse wheel up and down, cursor Table scroll up and down. Selected process does not
4.3 Mouse vertical scroll outside xy chart change. Vertical scroll bar updated. Pass

Tree viewer scrolls up and down. Selected process does not
4.4 Vertical scroll bar Click and drag vertical scroll bar change. Pass

Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new
Drag select time graph with right button in xy time range is propagated to other views. Selected process

4.5 Drag select time range chart remains the same. Pass
Tool tip shows the total and selected process (if any) cpu
4.6 Mouse hover Hover mouse in xy chart region anywhere usage at the time Pass It would be nice to display the process name i It would also be nice to crop the percentage

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
the mouse position, T1 the left most selected time, T2 the
right most selected time and delta the time difference
4.7 Drag mouse selection Drag select xy chart with left button between T2-T1 Status bar is not updated

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
Click select with left button (begin time), press the mouse position, T1 the left most selected time, T2 the
shift key and click select another time (end right most selected time and delta the time difference
4.8 Shift key selection time) between T2-T1 Shift key does not work in xy chart and status bar not updated



4.9

5.1

6.1

6.2

6.3

Sort columns Click on column headers once then twice

Keyboard handling

Keyboard navigation in tree With focus on table, use UP, DOWN, HOME,
viewer END keys

Synchronization

Select a random time in another view

) . Select a new time range in CPU usage view or
Time range synchronization in Histogram view.

Time synchronization

Time range selection
synchronisation

CPU usage works with
experiments

In any other view that supports range
synchronization, select a new range.

Entries are sorted in ascending then descending order on
the column value. Selected process does not change.

Selected process is changed. xy chart selection is updated.
Vertical scroll bar updated.

Selected time line is updated. If selected time is outside

H N " > No update if selected time outside current
current range, time range is updated to include it.

range

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time
range is outside the current range, then time range is

< > xy chart range does not include T1 ouside
updated to include it

current range



Target:

Step

0

0.1
0.2
0.3

1.1
1.2

1.6

1.6.5
1.7

Section
Trace Synchronization

Test Case

Prerequisites

Import traces
Create experiment 1
Create experiment 2

View Management

Open Synchronization
View

Delete view

Open view

Open Experiment

Synchronize experiment

Open view when trace is
already loaded

Synchronize experiment
with constant offset

Open trace
Re-open experiment

Restart
Functionnalities
Open experiment 2
Go back to previous
experiment

Synchronize experiment

Pass

Action

Import the scp_dest and scp_src traces in the
synctraces.tar.gz file

Create an experiment containing those 2 traces
Create an experiment with any other trace

Use menu Window - Show View - Other ... »
Tracing - Synchronization
Close the Synchronization View

Use menu Window - Show View - Other ... -
Tracing - Synchronization

Open the experiment containing the 2
synchronizable traces

Right-click on the experiment and select
'Synchronize experiment'

1) Close Synchronization View
2) Load LTTng experiment
3) Open 'Synchronization' view

Try to offset a trace by a second

Open an Lttng Kernel trace

Open the experiment containing the 2
synchronized traces

Restart Eclipse

Open the experiment containing traces that do not
synchronize

Re-open the experiment with the synchronizable
traces

Right-click on the experiment and select
'Synchronize traces'

Fail

Verification

Verify that 'Synchronization' view is shown
Synchronization' view is removed from perspective

Synchronization' view is displayed and remains empty

Verify that the view is still empty

After a time, the view is populated with synchronization
result that say 'accurate’. And one of the original traces
has been replace by a trace with the same name, but
withan'_'at the end.

Verify that view is populated with synchronization data
from currently opened experiment

Visually verify that a synchronized trace is now
offsetted

Synchronization view is empty

View shows synchronization data from the experiment

Verify that view is populated with synchronization data
from experiment

Verify that the 'Synchronization' view is empty

Verify that the 'Synchronization' view contains the data
from the experiment

After a time, the view is populated and the
synchronization quality says 'Absent’

To Do

Comment

| o |2

Pass
Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Comment

This view should be in properties

The view also makes no sense to mere mortals.

Absent is not displayed



Target:

Step

0.1

0.2

0.3

1.1

12

2.1

22

2.3
24

2.5
2.6
2.7
2.8
2.9

3.1

3.1

2.3

4.1

4.2

4.3

Section

XML analysis

Test Case

Prerequisites

Import traces

Get a test XML file

Make sure the XML file does

not exists in the project
XML file import

Verify analysis not present

Import XML file

View management

Populate the views

Open the 'Xml Control Flow
View'

Open another XML view

Close view

Open view when trace is
already loaded

Close traces

Open trace

Open another trace

Open LTTng Kernel trace
View selection

Select an entry in the table

Select entry in time graph

Select state in time graph

Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Zoom time range (mouse
drag)

Action

Import LTTng kernel traces
Download the test XML file here:

http://secretaire.dorsal.polymtl.ca/~gbastien/Xml4Tra

ces/Kernel.Linux.xml
The XML files are located in <workspace

directory>/.metadata/.plugins/org.eclipse.tracecompas

s.tmf.analysis.xml.core/xml_files. Delete the linux
kernel XML file if it exists.

In the project Explorer, expand any LTTng kernel
trace

Right-click the Traces folder, select Import XML
analysis and select the Kernel.Linux.xml file

Open an LTTng kernel trace

Double-click the 'Xml Control Flow View' under the

analysis

Double-click the 'Xml Resources View' under the
analysis

Close the XML view

Double-click one of the views under the analysis
Close all opened traces

Open an LTTng Kernel trace

Open a non-LTTng Kernel trace

Open an LTTng Kernel trace

Select an entry in the table

Select an entry in the time graph (empty region)

Select a state in the time graph

Drag move time graph left and right with middle
button

Zoom with mouse wheel up and down, cursor inside

time graph

Fail

Verification

Verify that there is no 'Xml kernel State System' analysis

Verify that the 'Xml kernel State System' analysis is now present]
under a LTTng kernel trace

The 'Xml kernel State System' analysis should have a + next to
it, expand it and there should be 2 views under it: "Xml Control
Flow View' and "Xml Resources View'

A view titled 'Xml Control Flow View' should open and it
should look quite similar to the Control Flow View

The new view replaces the 'Xml Control Flow View' and the
title changes to 'Xml Resources View'. This view is quite similar
to the Resources view's CPU entries.

The view is closed

The view opens with the correct title and is correctly populated.
The view is emptied.

The view is populated

The view is emptied.

The view is populated.

Same entry is highlighted in time graph.

Same entry is highlighted in table. Selected time line is updated.
Other views are synchronized to selected time.

Same entry is highlighted in table. State is highlighted in time
graph. Selected time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is released, states
are updated and new time range is propagated to other views.

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, states are
updated and new time range is propagated to other views.

Time range is zoomed in and out. When mouse button is
released, states are updated and new time range is propagated to

Drag in time graph scale left and right with left button other views.

To Do

Comment

[ o s

Pass

Pass

Pass

Pass
Pass

Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

- there are entries such as Unknown display quark for xxxx

After opening the resources view and going
back to the Control Flow view the legend
shows an extra entry (for value 4). This is
due to a concorrency bug.



44

45

4.6

4.7

4.8

4.9

4.11

5.1

52

5.4

5.4

6.1

6.2

6.3

6.4

6.5

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse seleection

Shift key selection
Keyboard handling

Keyboard navigation in table
(entry selection)

Keyboard navigation in table
(tree expansion)

Keyboard navigation in time
graph (process selection)

Keyboard navigation in time
graph (state selection)
Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out

Scroll with mouse wheel up and down, cursor outside
time graph

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time), press shift
key and click select another time (end time)

With focus on table, use UP, DOWN, HOME, END
keys

With focus on table,
in Windows use LEFT, RIGHT keys while parent or
child process is selected

in Linux use SHIFT LEFT, RIGHT keys while parent
or child process is selected

With focus on time graph, use UP, DOWN, HOME,
END keys

With focus on time graph, use LEFT, RIGHT keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button

Table and time graph scroll up and down and remain aligned.
Selected entry does not change. Vertical scroll bar updated.

Table and time graph scroll up and down and remain aligned.
Selected entry does not change.

Selection highlighted. When mouse button is released, time
range is zoomed to selection, states are updated and new time
range is propagated to other views.

Time range is reset to full range, states are updated and new
time range is propagated to other views.

Tool tip shows entry name only.

Tool tip shows entry name, state name, date, start time, end
time, duration.

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right most
selected time and delta the time difference between T2-T1

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right most
selected time and delta the time difference between T2-T1

Selected process is changed. Time graph selection is updated.
Vertical scroll bar updated.

For parent process, tree is expanded or collapsed. Time graph
item expansion is updated. Vertical scroll bar updated. For child
process, left changes selection to parent, time graph selection is
updated. Vertical scroll bar updated.

Selected process is changed. Table selection is updated. Vertical
scroll bar updated.

Previous or next state is selected. Selected time is updated in
other views.

The legend dialog is opened and can be closed.

Time range is reset to full range, states are updated and new
time range is propagated to other views.

Previous or next state is selected. Selected time is updated in
other views.

Selected process is changed in table and time graph. Vertical
scroll bar updated.

Time range is zoomed in and out, relative to center of time
range. States are updated and new time range is propagated to
other views.

Not all displayed colors are in the legend



6.6 Filter Dialog Open Filter Dialog Verify that all buttons are working correctly More filter buttons are available in cfv

1) Open Filter Dialog
2) Deselect several processes
6.7 Filter Processes 3) Press Ok Verify that only selected entries are displayed in the view

Selected time line is updated. If selected time is outside current
7.1 Time synchronization Select a random time in another view range, time range is updated to include it.

Select a new time range in Resources view or in
7.2 Time range synchronization  Histogram view. Time range is updated.

Selection is highlighted. If begin time (T1) of selected time

Time range selection In any other view that supports range synchronization, range is outside the current range, then time range is updated to
7.3 synchronisation select a new range. include it With T1 outside current range, the time range is not updated to include it.



To Do

Section Comment

Network Trace analysis

Target:
Step Test Case Action Verification Comment
0 Prerequisites
0.1 Import traces Import the trace linked here
1 Trace Import
Open the Network Tracing In the project Explorer, expand any LTTng Verify that the events view, the properties and
1.1 perspective kernel trace stream list are displayed Pass
The trace is given a "network" icon. When
openned, the events view and histogram view is
1.2 Open trace Double-click on the "TeamSpeak2.pcap" trace opened Pass
2 View management
2.1 Populate the views Open the "TeamSpeak2.pcap" The views are updated Pass
One stream is available with endpoint A being
2.2 Look up stream Open the Stream list Fe:FF:FF:FF:FF.FF Pass
2.3 Close the trace The stream list is emptied Pass
2.4 Close view Close the view The view is closed Pass
Open view when trace is The view opens with the correct title and is
2.5 already loaded Re-open the trace. Open The Stream List correctly populated. Pass
2.6 Open a non pcap trace The stream list is emptied Pass
3 Stream List
3.1 Re-open trace Ensure only "TeamSpeak2.pcap” is opened The trace is opened Pass
Create a filter from the A filter named "FILTER stream eth 00:0c:29..." is
3.1 stream list Right click on stream 0, and select "create filter" created Pass

In the events table, right click on an event and
3.2 Apply filter select "Apply preset filter->00:0c:29..." 24/24 events pass the filter Pass


http://wiki.wireshark.org/SampleCaptures?action=AttachFile&do=get&target=TeamSpeak2.pcap

Section

# Bug Reports

# Open # Fixed

Bug Reports

Test Case Bug Title

[TMF] Sequence Diagram Overview feature
Sequence Diagram 5.23 not working well on recent platform versions

LTTng 2 - Memory
Analysis 3.5, 3.6, CPU
Analysis 4.7, 4.8

LTTng 2 - Memory
Analysis 4.1, CPU
Analysis 6.1

LTTng 2 - Memory
Analysis 4.3, CPU
Analysis 6.3,
XmlAnalysis 7.3

[TMF] Status bar is not updated when
selecting time range in XY charts

[TMF] Time selection outside current range
should update current range in xy charts

[TMF] Time range selection outside current
range should update current range in time
graph views

[Ittng rcp] Opening a second trace with --open

RCP 1.4 activates the wrong editor

[TMF] Original experiment reappears after

Project View 6.5 rename and copy

Sequence diagram interaction tooltip is hard

Sequence Diagram 3.1 to read on Ubuntu

Button gets disabled in print dialog of
Sequence Diagram 5.24 sequence diagram after clicking on it

Bookmark is not removed right away, only
when the view is refreshed.

[TMF] Selection not updated in Histogram
Histogram View 3.7, 4.5 view when using right arrow key

Time Chart 5.6

[GTK][GTK 3.14] Search highlights are not

GDBTracing 7.1 drawn

Control view 17.9 NPE trying to destroy a session

SWTEXxception widget is disposed trying to

Control view 17.9 import trace from Control view

No password prompt when connecting with a

Remote Fetch 9.2

CPU Usage 2.3,
Memory Analysis 2.3

remote profile

Common X time axises not cleared when
trace is close

15 14 1

Bug Report Status

https://bugs.eclipse.org/bugs/show_bug.cgi?id=436442 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=436853 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=436861 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=436855 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=443461 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=436888 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=455523 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=455546 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=436323 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=468074 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=467933 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=469424 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=469425 Open

https://bugs.eclipse.org/bugs/show_bug.cgi?id=4694 36 Fixed

https://bugs.eclipse.org/bugs/show_bug.cgi?id=469644 Open
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https://bugs.eclipse.org/bugs/show_bug.cgi?id=455546
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